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About this document
HP Test Data Management provides powerful tools to design a test data 
management solution that copies data out of your production database for upload 
into a test database.

This guide provides information about:

• working with projects, models, and rules

• using parameters

• previewing test data files

• working with cartridges and business flows

• generating and deploying cartridges and business flows

• customizing projects

Intended audience

This guide is intended for:

• Test data developers building custom projects

Prerequisites

Prerequisites for using this product include:

• Knowledge of the operating system

• Database knowledge

• Application knowledge

Related documentation

In addition to this guide, please refer to other documents for this product:

• HP Test Data Management Installation guide 

Explains how to use the Installer to install the product. 

• HP Test Data Management Concepts guide
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Explains the major concepts of Test Data Management.

• HP Test Data Management Tutorial

Provides step-by-step instructions to build a sample test data module, deploy 
it, run it, and troubleshoot errors. 

• HP Test Data Management Runtime guide

Explains how to use the Web Console component to run, monitor, and 
administer business flows that move data to and from the database. 

• HP Test Data Management Troubleshooting guide 

Explains how to diagnose and resolve errors, and provides a list of common 
errors and solutions. 

• HP Test Data Management Release notes 

Lists any items of importance that were not captured in the regular 
documentation.

The latest documentation for the most recent HP Test Data Management release 
can be found on:

http://support.openview.hp.com/selfsolve/manuals

Document conventions and symbols

Convention Element

[ ] Indicates that the enclosed element is optional 
and may be left out.

{ } Indicates that you must specify one of the listed 
options.

| Separates alternatives.
8 About this document
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CAUTION Indicates that failure to follow directions could result in damage to 
equipment or loss of data.

NOTE Provides additional information.

TIP Provides helpful hints and shortcuts.

RECOMMENDATION Provides guidance from HP for a best practice or for 
optimum performance.

Documentation updates

For documentation for all versions of HP Test Data Management, you can go to:

http://support.openview.hp.com/selfsolve/manuals

<parameter_name> You must supply a value for a variable 
parameter.

... • Indicates a repetition of the preceding 
parameter.

• Example continues after omitted lines.

Medium blue text: Figure 1 Cross-reference links and e-mail addresses

Medium blue, underlined text 
(http://www.hp.com)

Web site addresses

Bold • Key names

• GUI elements that are clicked or selected, 
such as menu and list items, buttons, and 
check boxes

Italics Text emphasis

Monospace • File and directory names

• Text displayed on the screen, such as system 
output and application messages

• Code syntax

Monospace, italic You must supply a value.

• Code variables

• Command-line variables

Convention Element
HP Test Data Management Developer’s guide 9
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NOTE This documentation is written to the latest patch version. If you have not 
installed the latest patch, there may be items in this documentation that do not 
apply to your environment.

Subscription service

HP strongly recommends that customers sign up online using the Subscriber's 
choice web site:

 http://www.hp.com/go/e-updates

• Subscribing to this service provides you with e-mail updates on the latest 
product enhancements, versions of drivers, and firmware documentation 
updates as well as instant access to numerous other product resources.

• After signing up, you can quickly locate your products under Product 
Category.

Support

You can visit the HP Software Support web site at:

http://www.hp.com/go/hpsoftwaresupport 

HP Software Support Online provides an efficient way to access interactive 
technical support tools. As a valued support customer, you can benefit by using 
the support site to:

• Search for knowledge documents of interest

• Submit and track support cases and enhancement requests

• Download software patches

• Manage support contracts

• Look up HP support contacts

• Review information about available services

• Enter into discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign 
in. Many also require a support contract.

To find more information about access levels and register for HP Passport, go to:

http://support.openview.hp.com/new_access_levels.jsp
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1 Introduction to test data 
management
Test data management is a process where you typically copy a subset of data from 
your production database to a structured data file, such as an XML or comma 
separated values (CSV) file. Structured files provide open, standards-based 
formats that can be accessed using standard database mechanisms.

As part of the subsetting process, you perform the following:

• Apply eligibility requirements to the data. In most cases, you do not want 
all of the data from your production database. You need to define criteria that 
restrict the records copied. For example, you might only copy records that 
pertain to a certain period of time or customer.

• Mask sensitive data. Typically, your test database is not as secure as your 
production database. Hence, you need to mask any sensitive data, such as 
names, addresses, phone numbers, social security numbers, and so on. HP 
Test Data Management provides a variety of masking capabilities to help you 
protect confidential data.

Copying qualified records out of your active database and masking them is only 
the first leg in the lifecycle of test data management. Once you have the desired 
subset of data in a data extract file, you can upload from the file to a compatible 
test database. HP Test Data Management enables you to upload to heterogeneous 
databases, if necessary. For example, you may have extracted from a SQL Server 
database but need to upload to an Oracle database. You can also implement 
schema mapping in order to change the schema name when you load the data in 
the test database.

In addition to uploading the data from the extract file, you may also want to create 
a spreadsheet with some portion of the test data for use with other quality 
management tools. HP Test Data Management's query server enables you to 
quickly populate spreadsheets with test data from one or many database tables. 
Because you are using the extract file, the data you load into the spreadsheet is 
masked to your specifications and you can join tables, if necessary, without 
re-querying your source database.

This chapter includes: • Before you begin (page 12)

• Designer overview (page 12)

See also For a complete conceptual introduction to HP Test Data Management, refer to HP 
Test Data Management Concepts guide.
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Before you begin

Before you begin performing the tasks in this guide, you should:

1 Review the Concepts guide to become familiar with the software and how you 
plan to use it.

2 Install HP Test Data Management according to the instructions in the 
Installation guide.

3 Go through HP Test Data Management Tutorial. The tutorial enables you to 
get hands on with the product quickly and exposes you to many of the most 
commonly used features.

Designer overview

Most of the work of developing a test data management solution is performed in 
Designer. Designer is a powerful graphical development environment used to:

• Model data

• Apply rules

• Design cartridges

• Design business flows that employ cartridges and implement additional logic

• Preview models and cartridges for testing purposes

• Deploy cartridges and business flows

Designer drastically improves the productivity of test data developers. Developers 
no longer need to spend hours writing and debugging complex SQL. They simply 
drag and drop in Designer’s editor to include tables and relate them to other tables. 
Once the model is defined, developers can point and click to define rules and 
policies on tables as desired. When the business flows are ready, the developer can 
deploy them to any supported environment, local or remote, from Designer.

Navigation and interaction with the various components within Designer is 
consistent, and once familiar with the patterns in one portion of Designer, you 
should be able to work with any part of Designer.

This section includes: • Designer main window (page 12)

• Toolbar buttons (page 13)

• Projects and Connections (page 14)

• Preview (page 15)

Designer main window

The main window is the primary window you see and interact with while using 
Designer. The following figure shows an example of the main window and 
descriptions of its editors.
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Toolbar buttons

This section details the main toolbar buttons used in Designer. While using the 
tool, you may see different toolbar buttons. The purpose of this section is to 
introduce you to the most common toolbar buttons.

A

C

B

Legend Name Description

A Project
Navigator

Shows the files contained within the project

B Database 
Navigator

Shows the content of the database or local cache that the 
project is connected to

C Editor Space used to define model, cartridge, and business flow 
components, to view preview data, and to view database 
table data.

Icon Name Description

Save Save the active window.

Save All Save work in all currently open windows 
and tabs.

Undo Undo the last change.

Redo Redo the last undone action.
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Projects and Connections

All work to build a cartridge in Designer is performed within the context of a 
project. A finished project contains all the metadata definitions needed by the test 
data management software to copy your data.

Projects help you organize your work for a specific goal. 

You can define multiple connections, to databases and to local caches. Each 
project is associated with one connection.

Create New 
Project

Allows you to start creating a new project

Create New 
Model

Allows you to start creating a new model

Create New 
Cartridge

Allows you to create a new cartridge, if you 
have Models created

Create New 
Business Flow

Allows you to create a new business flow, if 
you have Cartridges created

Custom View Toggles custom view mode on or off. 
Custom view provides visual cues for 
locked projects that alert you to the 
customizations you are making and whether 
they are supported.

Add Chaining 
Table

Allows you to add a chaining table to a 
model

Add Transactional
Table

Allows you to add a transactional table to a 
model

Add Lookup 
Table

Allows you to add a lookup table to a model

Add Rule Allows you to add a rule to a model table

Preview Allows you to access the Designer’s 
preview functionality. 

Refresh Refreshes the data in preview from the 
database.

Icon Name Description
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Preview

Within Designer, you can preview the behavior of your model, rules, and 
cartridges. Preview provides a quick way to test your test data solution as you are 
building it. You need not wait until you deploy and run your cartridge to see how 
it will work. The best practice is to preview your solution at each stage of 
development and preview it repeatedly until you are certain it performs as 
expected.

For example, you can preview your model before you create any rules and then 
preview it again after you add each rule. Preview identifies the rows that are 
excluded as well as which rule causes their exclusion. When you create your 
cartridge, you can preview its behavior as well.
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2 Working with projects and 
connections
A project is a container that holds components, such as models, cartridges, and 
business flows, and connection information used to define your test data solution. 
The first steps in defining your test data solution are to create a project and a 
database connection in Designer.

This chapter explains how to work with projects and connections.

This chapter includes: • About projects (page 17)

• Creating a new project (page 18)

• Creating a connection (page 19)

• Changing projects (page 21)

• Annotating projects (page 21)

• Exporting and importing projects (page 24)

• Changing the project location (page 25)

• Mapping schema names (page 26)

About projects

All of the work to build a model, cartridge, or business flow in Designer is 
performed within the context of a project. A finished project contains all the 
metadata objects and definitions needed by HP Test Data Management to copy 
your data from the database to the data extract files (XML or CVS).

Projects can help you organize your work for specific goals. For example, you 
might create projects according to work phases or business areas. A sales project 
could copy data for the sales aspect of your business while a development project 
copies the data about the development efforts of your company.

A project is a logical container for:

• models

• cartridges

• business flows

• parameters
HP Test Data Management Developer’s guide 17



When logging onto Designer for the first time, it requires you to create a new 
project or open an existing project. All object definitions made during your work 
session are stored in a work space owned by the current project. Subsequent to 
that, Designer starts with your previously created projects available in the Project 
Navigator.

Creating a new project

To define a new project:

1 Start Designer. 

2 Select File > New Project.

3 In the Name field, type a name for the project. 

For example, Sales Order.

4 Select an existing database connection from the list or click New to define a 
new connection.

For more information, see Creating a connection (page 19).

5 If you are creating a project that is based on an existing project file (typically 
one provided to you by HP or a third party), then check Customize an 
Existing Project. Choosing this option indicates that you want to create a new 
project from an existing project.

6 Click OK. If you left Customize an Existing Project unchecked, the new 
project is created and you are done. If you checked Customize an Existing 
Project, then the Import Project dialog box displays.

7 In the Import Project dialog box, browse for the project file you wish to 
customize, which has the .hdp extension.

TIP .hdp is an exchange format for HP Test Data Management projects and 
contains all of the files associated with the project. You create .hdp files by 
exporting a project from Designer, File > Export Project.

8 Click Open. Designer extracts the project files from the selected .hdp file and 
the project appears in the Project Navigator. You can now modify the project 
as you would any other project in the Project Navigator.
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TIP If the project you selected is a locked project, then you should only 
perform limited customizations on it. For more information about 
customization, refer to Chapter 9, Customizing extraction projects.

Creating a connection

You can work with online connections or offline local caches. An online 
connection provides you with the data, but, if you are in the process of designing a 
test data solution on a remote database, you often do not require the data and 
working from the online connection may slow you down considerably. In such 
circumstances, it may be more efficient to create a local cache and work from the 
metadata rather than being continuously connected to the remote database. 
Furthermore, a local cache allows you to continue designing even when your 
computer is not connected to your network.

To create a new connection:

1 Click New from the New Project dialog box. 

or 

— Select Connection > Edit Connections. 

— Click New.

2 Select one of the following: 

Online Connection 

a Type a name for the connection. 

b Select a database type from the list of values. For example, SQL Server.

c Click Next.

Table 1 Database connection types

Connection Type Description

Online Connection Create a connection to a database

Local Cache Create a new local cache to capture the metadata 
information about an existing online connection. This 
option will enable you to work offline. To preview data 
when working offline, the underlying online connection 
must still be available to Designer because only metadata is 
stored in the local cache.
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d Type the connection information for the active database: 

e Click Finish. 

Table 2 Source database properties

Field Description

User Name Type the name of the user with permission to access the 
objects necessary to the creation of your cartridge. For 
example, sa.

Password Type the password. For example, imSn33ky. Save Password 
should only be checked when the data is not critical. Although 
the password is saved in an encrypted format, it does present a 
security risk.

For example, if you are working with a development database, 
it could be considered safe to save the password. On a 
production database, it would probably not be considered 
safe.

Host Type the name of the machine where the database is installed. 
For example, localhost. 

Port Type the port number for your database. For example, 5001.

URL For JDBC URL, the connection URL for the database. JDBC 
URLs are often used to connect to an Oracle database with 
RAC.

For example: 
jdbc:oracle:thin:@(DESCRIPTION=(SDU=32768)(en
able=broken)(LOAD_BALANCE=yes)(ADDRESS=(PROTO
COL=TCP)(HOST=gvu2707.austin.hp.com)(PORT=152
5))(ADDRESS=(PROTOCOL=TCP)(HOST=gvu2923.austi
n.hp.com)(PORT=1525))(CONNECT_DATA=(SERVICE_N
AME=SAPDEMI)))

SID For Oracle, the name of the database instance.

DB Server For SQL Server and Sybase, the name of the database server.

Database For SQL Server, the name of the database, for example, 
master.

Data Source For Neoview, the name of the database source.

Windows 
Authentication

For SQL Server, Windows Authentication indicates that the 
operating system login for the machine is the same as the SQL 
Server login, and once you are logged into the machine, you 
need not authenticate again for the SQL Server instance. If 
you do not select this option, the SQL Server login is distinct 
from the operating system login for the machine, and logging 
into the machine does not imply that you are authenticated for 
the SQL Server instance as well.
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Local Cache

a Type a name for the cache. 

b Select a database from the list of existing online connections. 

c Perform one of the following:

– Select All to capture metadata for all your databases, schemas, and 
tables. 

– Select particular databases, schemas, or tables to work with offline. In 
most cases, this choice is the most efficient and minimizes the 
overhead.

d Click Finish. 

Changing projects

As mentioned earlier, you may use multiple projects to categorize and organize 
your model, cartridge, and business flow development. If so, you need to switch 
among these projects within Designer.

1 Go to the Project Navigator. 

2 Select the project you want to work with from the list of values for the Project 
field. 

You are now working in and saving objects to the project that is selected and 
active.

Annotating projects

HP Test Data Management enables you to enter comments throughout your 
project for virtually every component. These comments help other developers and 
users better understand your project and all of its components. You can also 
generate a PDF file that contains all of your annotations as well as descriptions of 
the objects that makeup up the project components.

Annotating projects

1 From a dialog or page, click Annotation. The Annotation dialog displays.

TIP For projects, models, and cartridges, right click them in the Project 
Navigator and choose Edit Annotation.

2 For rules, the Annotation dialog box has a Category list from which you can 
optionally choose a category, such as Legal or Data Integrity. A category is 
not required. You can leave it as blank.
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3 Type your comment. Typically, a comment should explain what the element 
does and its significance. For example, a comment for a rule should explain 
the function of the rule and its underlying business condition.

4 Click OK.

Annotating cartridges

From each tab in the cartridge editor you can add specific annotations as follows:

• From the Operations tab, when you select a table, the Annotation button is 
enabled and you can add comments for that table.

• For the Data Masking tab, select a table and column, then click Annotation to 
enter comments about that column’s mask.

• For the model-based cartridge editor tabs, annotations behave as follows:

— For the File Indexes tab, the Annotation button is enabled when you select 
an existing index or click New to create a new one. You can add a 
separate comment for each named index.

— For the Column Inclusion tab, the Annotation button is enabled when you 
select a column for inclusion. If you make no changes to the default 
selections, the assumption is that you do not need to note any changed 
behavior in the annotations.

— For the Name Override tab, the Annotation button is enabled whenever 
you change the XML name for a column. If you make no changes, the 
assumption is that you need not note any changed behavior in the 
Annotations.

• For the Custom Properties tab, you can enter a comment for each property.

• For the following schema-based tabs, annotations behave as follows:

— For the Overview tab, the Annotation button is enabled when you select a 
table to be extracted.

— For the Data tab, the Annotation button only displays if you choose 
Selected Data.
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Generating and viewing documentation

For any project, you can generate documentation in PDF format that describes the 
project. The documentation includes a number of items, such as:

• title page and table of contents

• business flow diagrams and activities

• parameter lists

• model diagrams

• table use lists

• cartridge characteristics

• annotations

You can generate this documentation in one of two ways:

• Generating documentation from the Project Navigator (page 23)

• Generating documentation on deployment (page 24)

Generating documentation from the Project Navigator

1 In the Project Navigator, right click the project (the top-level node), and 
choose Generate Documentation. The Generate Documentation dialog box 
displays.

TIP You can also right click on individual cartridges and business flows in the 
Project Navigator to generate documentation for them. If you right click on 
the Cartridges or Business Flows nodes, it generates documentation for all 
cartridges or business flows.

2 Type or browse to the location where you want the PDF file generated. The 
PDF file will be placed in a business flow subdirectory in the chosen location.

3 Click OK.

4 Go to the location you chose and open the PDF file.
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Generating documentation on deployment

1 As you are deploying your cartridge or business flow in Deployment 
Assistant, on the Deployment Type page, check Include Documentation. 
Choosing this option creates a PDF file that describes the structure of your 
business flow along with any annotations you added to the business flow and 
the model. 

2 Go to the location of the PDF file. It should be in install_dir\obt\businessflow. 
For example:

C:\Program 
Files\HPTDM\obt\businessflow\<environment_name>
Orders_Bus_Flow.1_0_0_0.pdf

3 Open the PDF file.

Exporting and importing projects

Projects in Designer can be saved to .hdp files for exchange purposes. Typically, 
you export projects to .hdp files to share them with other users, who can then 
reuse and/or modify them.

Exporting projects

To export a project to .hdp:

1 In the Project Navigator, select the project from the list at the top.

2 Choose File > Export Project. The Export Project dialog box displays.

3 Navigate to the location where you want to save the .hdp file and enter the 
File name.

4 Click OK. The project files are saved to the .hdp file.

Importing projects

To import a project from a file with the .hdp extension:

1 Choose File > Import. The Import Project dialog box displays.

2 In the Import dialog box, choose Existing Designer project from the Import 
list. 

3 Click Next. The Import Existing Project dialog box displays.

4 Navigate to the location where the .hdp file is stored and select it.

5 Click Open. The project files are extracted and the project appears in the 
Project Navigator. Please note the following:

— The content of the imported project is added to the existing content of 
your current project.
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— Exporting/Importing a project exports/imports the models, cartridges, 
business flows, and parameters. The connection information is not 
exported/imported.

Importing a project for customization

To import a project for the purposes of customization:

1 In Designer, choose File > New Project. The New Project dialog box 
displays.

2 Enter a name for the project and select Customize an Existing Project.

3 Click OK. The Import Project dialog, from which you can select a .hdp file, 
displays.

4 Browse to and select the .hdp file that you received from your vendor.

5 Click Open. The selected project is imported into Designer under the 
specified project name. Please note the following:

— Exporting/Importing a project exports/imports the models, cartridges, 
business flows, and parameters. The connection information is not 
exported/imported.

— If the project you imported is a locked project, then you should only 
perform limited customizations on it. For more information about 
customization, refer to Chapter 9, Customizing extraction projects.

— If you are dealing with a locked project from a third party, you would only 
import it the first time you receive it. Subsequently, when the third party 
provides you with project revisions, you would use Customization > 
Merge Project to bring in the updates.

Changing the project location

By default, all projects are saved to the user directory. For example, on MS 
Windows: 

C:\Documents and Settings\<username>\HPTDM\Designer

where <username> is the name of the Windows user. 
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If you want to save your projects to a different directory, start Designer from the 
command line using the -data option. For example: 

designer.exe -data “c:\<NewDirectory>”

where <NewDirectory> is the location where you want to store your project data. 
Project data will be stored in directories named for the projects under the specified 
location.

Mapping schema names

In some cases, you may find that you need to run your project against different 
schema instances with different names. For example, you might be using two 
database instances. In one instance, the schema might be called DEMARC and, in 
another, DEMARCDATA. In such situations, it is convenient to be able to map the 
schema names to avoid problems when switching between connections. Instead of 
using a hard coded schema name, you can create a logical alias and map it to the 
physical schema.

TIP You can use schema mapping to develop multi-database cartridges. For 
example, you could map HR to hr.dbo. In that case, a table called 
HR.EMPLOYEES on Oracle would be mapped to hr.dbo.EMPLOYEES on SQL 
Server. Refer to Example (page 27).

To map schema:

1 Open your project in Designer.

2 Select Connection > Map Schemas.

3 In the Schema Mapping dialog box, type a Logical Name or select it by 
clicking Choose Schema. For example, you could type DEMARC as the Logical 
Name. The logical name is the alias that you want to use within Designer 
when referring to the physical schema name.

4 Click the adjacent cell under Physical Name. Type or choose a Physical 
Name. The physical name is the name of the schema in the database for which 
you want to create an alias (logical name).
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NOTE Schema mappings are associated with the connection.

5 Click OK. Instead of using the physical name (for example, 
DEMARCDATA), Designer now uses the logical name (for example, 
DEMARC). If you later must use a different underlying physical name 
(DEMARCDB), you can simply come back to this dialog and change the 
Physical Name value accordingly.

TIP To delete a mapping, return to the Schema Mapping dialog box, click on 
the mapping you wish to remove, and click Remove.

6 (Optional) Browse your project and notice some of the changes:

— Under the Project Navigator, in the Database Navigator, the logical 
schema name appears in its own top-level node with the physical schema 
name in parentheses next to it.

— The Table Use Properties dialog box for a table associated with the logical 
schema name will appear differently. Instead of showing a read-only 
Table Name field, the dialog displays two read-only fields, Mapped Table 
Name and Database Table Name.

Example Suppose that you have imported a project that was built against an Oracle 
database into a Designer instance running against a SQL Server database with 
some slight variation in the schema. To avoid reimplementing your model, you 
can simply map the schemas:

1 Select Connection > Map Schemas. The Schema Mapping dialog box 
appears.

 

2 Click in the first cell under Logical Name and type DEMARC.

3 Click in the first cell under Physical Name.

4 Click Choose Schema.

5 In the Choose Schema dialog box, expand DEMARC.

6 Select dbo.
HP Test Data Management Developer’s guide 27



7 Click OK.

8 Click OK. The imported model should now work against the SQL Server 
database.
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3 Working with models
Within HP Test Data Management, you can identify the data to be extracted in one 
of two ways:

• Selecting tables in a schema. This method of identifying data is described in 
Chapter 6, Working with cartridges.

• Building one or more models that represents the tables and data relationships.

A model represents the tables from which you want to copy data and their 
relationships. In this context, the term table actually refers to a use of a table, 
synonym, or view in the model. A table use can represent a table, view, or a 
synonym to a table or view. The same table can appear multiple times in a model. 
For example, a table could be appear as a transactional table and a lookup table in 
the same model.

You apply rules to your tables to:

• Set the scope of extraction, such as only extract orders older than two years.

• Exclude certain records (such as excluding orders that are not open).

In building your model, you use Designer to discover database definitions and add 
them to your model. However, before you begin creating your model, you must 
have a good understanding of your business entity and table. You can also use 
Designer to validate rule definitions added against the active database. 

This chapter includes: • Before you begin (page 30)

• About models (page 30)

• Creating a new model (page 30)

• Adding transactional tables (page 32)

• Adding lookup tables (page 39) 

• Adding chaining tables (page 45)

• Managing associated tables (page 50)

• Working with rules (page 50)

• Working with virtual unique and foreign keys (page 54)

• Modifying object properties (page 59)

• Locating a table (page 59)

• Drag and drop a table (page 59)
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Before you begin

Before building your model, you need to perform some careful analysis and 
planning. For some ideas about what you must know and take into account before 
building your test data solution, refer to HP Test Data Management Concepts 
guide.

TIP Designing your models is much easier if you already have an 
entity-relationship diagram and know the cardinality of each role in the 
relationships.

About models

A model represents the tables and relationships that define transactions as test data 
candidates. A model captures the logic of the application whereas a cartridge 
based upon the model defines a specific usage of the model.You can define as 
many rules as needed on any model object (driving, transaction, lookup, or 
chaining) to further limit the universe of eligible rows for extraction. 

Rules articulate business conditions, often parameterized, that determine what 
data to include in the XML or CSV files. For example, you can create a rule that 
includes billing transactions that are at least two years old. To further refine the 
selection of records, you can create rules that define exceptions to the business 
conditions. For example, you can create a rule to exclude all orders that have not 
been shipped regardless of their age. 

Creating a new model

To create a new model:

1 Select Models in the Project Navigator.

2 Right-click and select New Model. The New Model dialog opens. 

3 Type a name for the model, for example, salesorder. 

4 If known, type the fully-qualified name of the Driving Table. If not, explore 
the database to which you are connected and find the table:
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a Click the browse button at the end of the field.

b Type a string or a partial string in the Filter field, such as order. 

TIP In the case of Oracle, a lowercase filter criteria returns uppercase, 
matching names.

c Click Search.

 

d Highlight the table you want as the driving table. If Designer can find a 
primary key or a unique key without nullable columns to act as a data 
movement key, then you are not prompted further. Otherwise, you may be 
prompted to add a virtual unique key. 

Synonyms and views In some cases, you may need to copy data from views or synonyms 
instead of the base tables. For example, if you need to copy data from a 
table that resides in another database, you can create a synonym in the 
local database that refers to that remote table. When you use synonyms 
and views, bear in mind the following:

– Multi-table views are not supported in the case of Oracle. You should 
instead copy data from each of the tables in the multi-table view 
individually.

– Synonyms must be recognized as local objects. Remote synonyms or 
sysnonyms created as though they were remote are not supported.

e Click OK in the Browse window. 

5 Once the Driving Table field is populated, click OK. The new model opens in 
the Editor. 
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TIP To delete a model, right click it in the Project Navigator and choose Delete 
from the menu. If you have created cartridges based on the model, Designer will 
not allow you to delete it until you have first deleted the cartridges.

Adding transactional tables

If the relationship between two tables is one to many (parent to child), you should 
add the second (child) table as a transactional table. If the relationship is many to 
one, you would add it as a lookup or chaining table. Refer to Adding lookup tables 
(page 39) or Adding chaining tables (page 45).

You can add transactional tables in one of two ways:

• If your database has foreign key relationships defined or if you have already 
created virtual foreign key relationships for the model, you can use them to 
relate transactional tables in the model.

• If you cannot use existing foreign key relationships, you can add transactional 
tables through the All Tables tab.

TIP To ensure optimal performance, you should consider creating an index for any 
columns that you plan to use in a virtual constraint. Otherwise, your performance 
may be slow and you could encounter deadlocks.

Both of these methods are described in this section:

• Adding transactional tables using foreign key relationships (page 33)

• Adding transactional tables using the All Tables tab (page 34)

Synonyms and views In some cases, you may need to extract views or synonyms instead of the base 
tables. For example, if you need to extract a table that resides in another database, 
you can create a synonym in the local database that refers to that remote table. 
When you use synonyms and views, bear in mind the following:

• Multi-table views are not supported in the case of Oracle. You should instead 
extract each of the tables in the multi-table view individually.

• Synonyms must be recognized as local objects. Remote synonyms or 
synonyms created as though they were remote are not supported.
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Multiple table uses You can add the same table multiple times to the same model and each instance of 
the table can fulfill different functions (transactional table, chaining table, or 
lookup table). When working with multiple table uses, you should be aware of the 
following points:

• Whenever you have multiple uses of a table and those uses are disjoint (no 
overlapping rows), you can use standard selection. When the table uses have 
overlapping rows, standard selection can yield unexpected results. Hence, 
when rows overlap among multiple table uses, you should use advanced 
selection.

TIP To ensure the set of rows for each table use are unique, you can attach a 
condition to the relationship that restricts the rows returned. Refer to HP Test 
Data Management Tutorial for an example of multiple table uses where a 
condition restricts the rows for each usage.

• Multiple table uses can have arbitrarily different operations associated with 
them. Ultimately, though, each use of the table maps to the same physical 
table. Hence, a row satisfying two or more table use selections might 
experience conflicting operations. The data movement process uses the 
following rule to resolve such operational conflicts:

— If one table use has no operation and another has any operation, the latter 
table use’s operation is used on a row belonging to both table uses.

Adding transactional tables using foreign key relationships

To add transactional tables using foreign key relationships:

1 Open a model in Designer. 

2 Right click a driving, transactional, or chaining table and select Add 
Transactional Table.

3 On the By Foreign Keys tab, select the table you want to add. 

For example, SalesOrderDetail. 

You can expand the details to see the foreign key relationship.

TIP If you select multiple foreign keys, multiple table uses are added to the 
model when you click Finish.
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4 Click Next.

For non-Oracle data sources, when you click Next, you may be prompted to 
specify a unique key to use as the data movement key. For Oracle, ROWID is 
automatically used as the data movement key and this dialog is skipped. For 
non-Oracle data sources, the primary key is chosen automatically, but, if there 
is no primary key, you are prompted to provide a data movement key.

You can specify an existing unique key or create a new one to act as the data 
movement key.

NOTE You must ensure that, in the context of the data being extracted, the 
data movement key contains no null column values. Otherwise, the rows 
associated with the null values will not be included in your extracted data.

5 Click Finish.

Adding transactional tables using the All Tables tab

To add transactional tables using the All Tables tab:

1 Open a model in Designer. 

2 Right click the driving table and select Add Transactional Table.

3 Select the All Tables tab.

4 Optionally, type a string or a partial string in the Filter field. 

5 Click Search.

6 Select the table you want. 

7 Click Next. 

The Specify How to Use or Build Keys page opens. If the child table has an 
available foreign key (virtual or database) related to the parent or the parent 
table has an available unique key (virtual or database), the page displays those 
keys for your selection. If the child has no such foreign key, the topmost radio 
button does not appear. If the parent has no unique key, the page appears with 
only the two bottom radio buttons.
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8 Choose one of the following radio buttons: 

Table 3 Key specification

Selection Description Next steps

Choose an 
existing foreign 
key

If you already have a foreign 
key or a virtual foreign key, 
you can choose that existing 
key.

• Highlight a foreign key 
from the list. 

• For Oracle, you can 
click Finish. For 
non-Oracle, click Next 
and, when satisfied with 
the settings and it 
becomes enabled, click 
Finish. The table is 
added to the model and 
you can skip the 
remainder of the steps 
in this section.

• If you select multiple 
foreign keys, multiple 
table uses are added to 
the model when you 
click Finish.

Create a new 
foreign key 
associated with 
the following 
unique key or 
index

If the parent table has a unique 
or primary key but the child 
table has no foreign key, you 
can create a new foreign key 
associated with the existing 
unique key.

• Highlight a unique key. 

• Click Next. 

• Continue with step 11.

Create a new 
unique key and 
foreign key

If the parent table has no 
unique key, you can create a 
new unique key on the parent 
table, and then a new foreign 
key on the child table.

• Click Next. 

• Continue with step 9.

Create a new 
foreign key based 
only one a 
conditional 
relationship

If the parent table has no 
unique key, you can create a 
foreign key based entirely on a 
relationship filter.

• Click Next.

• Define a condition for 
the virtual foreign key.

• For non-Oracle, define 
the data movement key.

• Click Finish.
36 Chapter 3: Working with models



9 If you chose Create a new unique key and foreign key, the Unique Key page 
displays. Type or select the following values:

10  Click Next. 

11 On the Foreign Key page, type or select the following values: 

Table 4 Unique key definition

Field Description

Name Accept or type a new name for the key.

Available Columns These columns in the table could be used to define the 
key. Highlight values in the Available Columns table. 
Use the shuttle buttons to move columns back and forth 
from the Available Columns and Key Columns lists as 
necessary.

Key Columns These columns are the ones selected to define the key. 
Highlight values in the Key Columns table. Use the 
shuttle buttons to move columns back and forth from 
the Available Columns and Key Columns lists as 
necessary.

Shuttle buttons (>,<) Use shuttle buttons to move columns back and forth 
between Available Columns and Key Columns.

Up and Down buttons Use to order the columns in the Key Columns field.

Sort Sorts the Available Columns in alphabetical order.

Table 5 Foreign key definition

Field Description

Name Accept or type a new name for the key.

Available Columns These columns in the table could be used to define the 
key. Highlight values in the Available Columns table. 
Use the shuttle buttons to move columns back and forth 
from the Available Columns and Key Columns lists as 
necessary.

Key Columns These columns are the ones selected to define the key. 
Highlight values in the Key Columns table. Use the 
shuttle buttons to move columns back and forth from 
the Available Columns and Key Columns lists as neces-
sary.

Shuttle buttons (>,<) Use shuttle buttons to move columns back and forth 
between Available Columns and Key Columns.

Up and Down buttons Use to order the columns in the Key Columns field.

Sort Sorts the Available Columns in alphabetical order.
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12 Click Next.

For non-Oracle data sources, when you click Next, you are prompted to 
specify a unique key to use as the data movement key. For Oracle, ROWID is 
automatically used as the data movement key and this dialog is skipped. For 
non-Oracle data sources, the primary key is chosen automatically, but, if there 
is no primary key, you are prompted to provide a data movement key.

You can specify an existing unique key or create a new one to act as the data 
movement key.

NOTE You must ensure that, in the context of the data being extracted, the 
data movement key contains no null column values. Otherwise, you will have 
null values in your extracted data.

13 If you were prompted for a data movement key, click Next.

14 Optionally, use the Conditional Relationship page to define a SQL WHERE 
clause to filter the relationship.

15 Click Finish.

Table 6 Conditional relationship definition

Field Description

Database Choose the database to which the WHERE clause 
applies. You can have a different WHERE clause for as 
many of the vendors and versions as necessary. For 
example, you could associate a different WHERE 
clause with SQL Server, Sybase, and Oracle. At 
runtime, HP Test Data Management can determine the 
database vendor and version, and apply the clause that 
you assigned to that vendor and version.

• Choose Any for the default WHERE clause. The 
Any WHERE clause is used for any vendor and 
version for which does not have an assigned 
WHERE clause. For example, if you do not assign a 
WHERE clause to Oracle or any of its versions, the 
Any WHERE clause will be used when deploying 
against Oracle.

• If the clause has vendor or version specific calls or 
syntax in it, expand the Any node until you see the 
necessary option for the clause and select it.

WHERE Type or edit the WHERE clause.

Columns Double-click the column name to insert the name into 
the WHERE clause. 

<<Insert Alternatively, highlight a column and use the <<Insert 
button to move it to the WHERE clause.

Associated Tables Refer to Managing associated tables (page 50).
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Adding lookup tables

Lookup tables contain non-transactional data, such as status codes or product 
identifiers. If the relationship between two tables is many to one and the data is 
non-transactional, you should add the second table as a lookup table. Otherwise, 
you should add it as a transactional or chaining table. Refer to Adding 
transactional tables (page 32) or Adding chaining tables (page 45).

You can add lookup tables in one of two ways:

• If your database has foreign key relationships defined or if you have virtual 
foreign key relationships defined in Designer, you can use those to relate 
tables in the model.

• If you cannot use existing foreign key relationships for some reason, you can 
add tables through the All Tables tab.

TIP To ensure optimal performance, you should consider creating an index for any 
columns that you plan to use in a virtual constraint. Otherwise, your performance 
may be slow and you could encounter deadlocks.

Both of these methods are described in this section:

• Adding lookup tables using the foreign key relationships (page 40)

• Adding lookup tables using the All Tables tab (page 40)

Synonyms and views In some cases, you may need to extract views or synonyms instead of the base 
tables. For example, if you need to extract a table that resides in another database, 
you can create a synonym in the local database that refers to that remote table. 
When you use synonyms and views, bear in mind the following:

• Multi-table views are not supported in the case of Oracle. You should instead 
extract each of the tables in the multi-table view individually.

• Synonyms must be recognized as local objects. Remote synonyms or 
sysnonyms created as though they were remote are not supported.

Multiple table uses You can add the same table multiple times to the same model and each instance of 
the table can fulfill different functions (transactional table, chaining table, or 
lookup table). When working with multiple table uses, you should be aware of the 
following points:

• Whenever you have multiple uses of a table and those uses are disjoint (no 
overlapping rows), you can use standard selection. When the table uses have 
overlapping rows, standard selection can yield unexpected results. Hence, 
when rows overlap among multiple table uses, you should use advanced 
selection.

TIP To ensure the set of rows for each table use are unique, you can attach a 
condition to the relationship that restricts the rows returned. Refer to HP Test 
Data Management Tutorial for an example of multiple table uses where a 
condition restricts the rows for each usage.
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• Multiple table uses can have arbitrarily different operations associated with 
them. Ultimately, though, each use of the table maps to the same physical 
table. Hence, a row satisfying two or more table use selections might 
experience conflicting operations. The data movement process uses the 
following rule to resolve such operational conflicts:

— If one table use has no operation and another has any operation, then the 
latter table use’s operation is used on a row belonging to both table uses.

Adding lookup tables using the foreign key relationships

1 Open a model in Designer. 

2 Right-click a table and select Add Lookup Table. 

3 On the By Foreign Keys tab, select the table you want to add. 

For example, SalesOrderDetails. 

You can expand the details to see the foreign key relationship. 

TIP If you select multiple foreign keys, multiple table uses are added to the 
model when you click Finish.

4 For non-Oracle data sources, when you click Next, you are prompted to 
specify a unique key to use as the data movement key. For Oracle, ROWID is 
automatically used as the data movement key and this dialog is skipped. For 
non-Oracle data sources, the primary key is chosen automatically, but, if there 
is no primary key, you are prompted to provide a data movement key.

You can specify an existing unique key or create a new one to act as the data 
movement key.

NOTE You must ensure that, in the context of the data being extracted, the 
data movement key contains no null column values. Otherwise, you will have 
null values in your extracted data.

5 Click Finish.

Adding lookup tables using the All Tables tab

1 Right-click the driving table and select Add Lookup Table. 

2 Select the All Tables tab. 

3 Optionally, type a string or a partial string in the Filter field. 

4 Click Search. 

5 Select the table you want. 

6 Click Next.

The Specify How to Use or Build Keys page opens. If the parent table has an 
available foreign key (virtual or database) related to the child or the child 
table has an available unique key (virtual or database), the page displays those 
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keys for your selection. If the parent has no such foreign key, the topmost 
radio button does not appear. If the child has no unique key, the page appears 
with only the two bottom radio buttons.
HP Test Data Management Developer’s guide 41



7 Choose one of the following radio buttons: 

Table 7 Key specification

Selection Description Next steps

Choose an 
existing foreign 
key

If you already have a foreign 
key or a virtual foreign key, 
you can choose that existing 
key.

• Highlight a foreign key 
from the list. 

• For Oracle, you can 
click Finish. For 
non-Oracle, click Next 
and, when satisfied with 
the settings and it 
becomes enabled, click 
Finish. The table is 
added to the model and 
you can skip the 
remainder of the steps 
in this section.

• If you select multiple 
foreign keys, multiple 
table uses are added to 
the model when you 
click Finish.

Create a new 
foreign key 
associated with 
the following 
unique key or 
index

If the child table has a unique 
or primary key but the parent 
table has no foreign key, you 
can create a new foreign key 
associated with the existing 
unique key.

• Highlight a unique key. 

• Click Next.

• Continue with step 10.

Create a new 
unique key and 
foreign key

If the child table has no unique 
key, you can create a new 
unique key on the child table, 
and a new foreign key on the 
parent table.

• Click Next. 

• Continue with step 8.

Create a new 
foreign key based 
only on a 
conditional 
relationship

If the child table has no unique 
key, you can create a foreign 
key based entirely on a 
relationship filter.

• Click Next.

• Define a condition for 
the virtual foreign key.

• For non-Oracle, define 
the data movement key.

• Click Finish.
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8 If you chose Create a new unique key and foreign key, the Unique Key page 
displays. Type or select the following values:

9 Click Next. 

10 Use the Foreign Key page to define a new foreign key: 

11 Click Next. 

Table 8 Unique key definition

Field Description

Name Accept or type a new name for the key.

Available Columns These columns in the tables could be used to define the 
key. Highlight values in the Available Columns table. 
Use the shuttle buttons to move columns back and forth 
from the Available Columns and Key Columns lists as 
necessary.

Key Columns These columns are the ones selected to define the key. 
Highlight values in the Key Columns table. Use the 
shuttle buttons to move columns back and forth from 
the Available Columns and Key Columns lists as neces-
sary.

Shuttle buttons (>,<) Use shuttle buttons to move columns back and forth 
between Available Columns and Key Columns.

Up and Down buttons Use to order the columns in the Key Columns field.

Sort Sorts the Available Columns in alphabetical order.

Table 9 Foreign key definition

Field Description

Name Accept or type a new name for the key.

Available Columns Highlight values in the Available Columns table. Use 
Shuttle button (>) to move columns from Available 
Columns to Key Columns.

Key Columns Highlight values in the Key Columns table. Dou-
ble-click or use Shuttle buttons to move columns from 
Available Columns to Key Columns or back again.

Shuttle buttons (>,<) Use shuttle buttons to move columns back and forth 
between Available Columns and Key Columns.

Up and Down buttons Use to order the columns in the Key Columns field.

Sort Sorts the Available Columns in alphabetical order.
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For non-Oracle data sources, when you click Next, you are prompted to 
specify a unique key to use as the data movement key. For Oracle, ROWID is 
automatically used as the data movement key and this dialog is skipped. For 
non-Oracle data sources, the primary key is chosen automatically, but, if there 
is no primary key, you are prompted to provide a data movement key.

You can specify an existing unique key or create a new one to act as the data 
movement key.

NOTE You must ensure that, in the context of the data being extracted, the 
data movement key contains no null column values. Otherwise, you will have 
null values in your extracted data.

12 If you were prompted for a data movement key, click Next.

13 Optionally, use the Conditional Relationship page to define a SQL WHERE 
clause to filter the relationship. 

14 Click Finish. 

Table 10 Conditional relationship definition

Field Description

Database Choose the database to which the WHERE clause applies. 
You can have a different WHERE clause for as many of the 
vendors and versions as necessary. For example, you could 
associate a different WHERE clause with SQL Server, 
Oracle 8i, and Oracle 9i. At runtime, HP Test Data 
Management can determine the database vendor and 
version, and apply the clause that you assigned to that 
vendor and version.

• Choose Any for the default WHERE clause. The Any 
WHERE clause is used for any vendor and version for 
which does not have an assigned WHERE clause. For 
example, if you do not assign a WHERE clause to Oracle 
or any of its versions, the Any WHERE clause will be 
used when deploying against Oracle.

• If the clause has vendor or version specific calls or 
syntax in it, expand the Any node until you see the 
necessary option for the clause and select it.

WHERE Type or edit the WHERE clause.

Columns Double-click the column name to insert the name into the 
WHERE clause. 

<<Insert Alternatively, highlight a column and use the <<Insert 
button to move it to the WHERE clause.

Associated Tables Refer to Managing associated tables (page 50).
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Adding chaining tables

If the relationship between two tables is many to one and the data is not lookup 
data, you should add the second table as a chaining table. Otherwise, you would 
add it as a lookup or transactional table. Refer to Adding transactional tables 
(page 32) or Adding lookup tables (page 39).

You can add chaining tables in one of two ways:

• If your database has foreign key relationships defined or virtual foreign key 
relationships, you can use those to relate tables in the model.

• If you cannot use existing foreign key relationships for some reason, you can 
add tables through the All Tables tab.

TIP If you have a chaining table in your model, you must choose the advanced 
selection option for the associated cartridges. Refer to HP Test Data Management 
Concepts guide for more information about advanced selection.

TIP To ensure optimal performance, you should consider creating an index for any 
columns that you plan to use in a virtual constraint. Otherwise, your performance 
may be slow and you could encounter deadlocks.

Both of these methods are described in this section:

• Adding chaining tables using the foreign key relationships (page 46)

• Adding chaining tables using the All Tables tab (page 46)

Synonyms and views In some cases, you may need to extract views or synonyms instead of the base 
tables. For example, if you need to extract a table that resides in another database, 
you can create a synonym in the local database that refers to that remote table. 
When you use synonyms and views, bear in mind the following:

• Multi-table views are not supported in the case of Oracle. You should instead 
extract each of the tables in the multi-table view individually.

• Synonyms must be recognized as local objects. Remote synonyms or 
sysnonyms created as though they were remote are not supported.

Multiple table uses You can add the same table multiple times to the same model and each instance of 
the table can fulfill different functions (transactional table, chaining table, or 
lookup table). When working with multiple table uses, you should be aware of the 
following points:

1 Whenever you have multiple uses of a table and those uses are not disjoint 
(overlapping rows), it is advised that you use advanced selection. When you 
have table uses with overlapping rows, standard selection can yield 
unexpected results.

2 Multiple table uses can have arbitrarily different operations associated with 
them. Ultimately, though, each use of the table maps to the same physical 
table. Hence, a row satisfying two or more table use selections might 
experience conflicting operations. The data movement process uses the 
following rules to resolve such operational conflicts:
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— If one table use has no operation and another has any operation, then the 
latter table use’s operation is used on a row belonging to both table uses.

Adding chaining tables using the foreign key relationships

1 Open a model in Designer. 

2 Right click a driving, transactional, or chaining table and select Add Chaining 
Table. 

3 On the By Foreign Keys tab, select the table you want to add. 

For example, SalesOfferProduct. 

You can expand the details to see the foreign key relationship. 

TIP If you select multiple foreign keys, multiple table uses are added to the 
model when you click Finish.

4 Click Next.

For non-Oracle data sources, when you click Next, you are prompted to 
specify a unique key to use as the data movement key. For Oracle, ROWID is 
automatically used as the data movement key and this dialog is skipped. For 
non-Oracle data sources, the primary key is chosen automatically, but, if there 
is no primary key, you are prompted to provide a data movement key.

You can specify an existing unique key or create a new one to act as the data 
movement key.

NOTE You must ensure that, in the context of the data being extracted, the 
data movement key contains no null column values. Otherwise, you will have 
null values in your extracted data.

5 Click Finish. 

Adding chaining tables using the All Tables tab

1 Right-click a driving, transactional, or chaining table and select Add 
Chaining Table. 

2 Select the All Tables tab. 

3 Optionally, type a string or a partial string in the Filter field. 

4 Click Search. 

5 Highlight the table you want. 

6 Click Next. 

The Specify How to Use or Build Keys page opens. If the parent table has an 
available foreign key (virtual or database) related to the child or the child 
table has an available unique key (virtual or database), the page displays those 
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keys for your selection. If the parent has no such foreign key, the top portion 
of the page does not appear. If the child has no unique key, the page does not 
appear at all.

7 Choose one of the following radio buttons:

TIP If you select multiple foreign keys, multiple table uses are added to the 
model when you click Finish.

Table 11 Key specification

Selection Description Next steps

Choose an 
existing foreign 
key

If you already have a foreign 
key or a virtual foreign key, 
you can choose that existing 
key.

• Highlight a foreign key 
from the list. 

• For Oracle, you can 
click Finish. For 
non-Oracle, click Next 
and, when satisfied with 
the settings and it 
becomes enabled, click 
Finish. The table is 
added to the model and 
you can skip the 
remainder of the steps 
in this section.

Create a new 
foreign key 
associated with 
the following 
unique key or 
index

If the child table has a unique 
or primary key but the parent 
table has no foreign key, you 
can create a new foreign key 
pointing to the existing unique 
key.

• Highlight a unique key. 

• Click Next to create the 
foreign key 

• Continue with step 10.

Create a new 
unique key and 
foreign key

If the child table has no 
unique key, you can create a 
new unique key on the child 
table, and a new foreign key 
on the parent table.

• Click Next. 

• Continue with step 8.

Create a new 
foreign key based 
only on a 
conditional 
relationship

If the child table has no unique 
key, you can create a foreign 
key based entirely on a 
relationship filter.

• Click Next.

• Define a condition for 
the virtual foreign key.

• Click Finish.
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8 If you chose Create a new unique key and foreign key, the Unique Key page 
displays to define a new unique key:

9 Click Next. 

10 Use the Foreign Key page to define a new foreign key: 

11 Click Next. 

Table 12 Unique key definition

Field Description

Name Accept or type a new name for the key.

Available 
Columns

These columns in the tables could be used to define the key. 
Highlight values in the Available Columns table. Use the 
shuttle buttons to move columns back and forth from the 
Available Columns and Key Columns lists as necessary.

Key Columns These columns are the ones selected to define the key. 
Highlight values in the Key Columns table. Use the shuttle 
buttons to move columns back and forth from the Available 
Columns and Key Columns lists as necessary.

Shuttle buttons 
(>,<)

Use shuttle buttons to move columns back and forth 
between Available Columns and Key Columns.

Up and Down 
buttons

Use to order the columns in the Key Columns field.

Sort Sorts the Available Columns in alphabetical order or 
preserves the database order.

Table 13 Foreign key definition

Field Description

Name Accept or type a new name for the key.

Available 
Columns

These columns in the tables could be used to define the key. 
Highlight values in the Available Columns table. Use the 
shuttle buttons to move columns back and forth from the 
Available Columns and Key Columns lists as necessary.

Key Columns These columns are the ones selected to define the key. 
Highlight values in the Key Columns table. Use the shuttle 
buttons to move columns back and forth from the Available 
Columns and Key Columns lists as necessary.

Shuttle buttons 
(>,<)

Use shuttle buttons to move columns back and forth 
between Available Columns and Key Columns.

Up and Down 
buttons

Use to order the columns in the Key Columns field.

Sort Sorts the Available Columns in alphabetical order.
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For non-Oracle data sources, when you click Next, you are prompted to 
specify a unique key to use as the data movement key. For Oracle, ROWID is 
automatically used as the data movement key and this dialog is skipped. For 
non-Oracle data sources, the primary key is chosen automatically, but, if there 
is no primary key, you are prompted to provide a data movement key.

You can specify an existing unique key or create a new one to act as the data 
movement key.

NOTE You must ensure that, in the context of the data being extracted, the 
data movement key contains no null column values. Otherwise, you will have 
null values in your extracted data.

12 If you were prompted for a data movement key, click Next.

13 Optionally, use the Conditional Relationship page to define a SQL WHERE 
clause to filter the relationship. 

14 Click Finish. 

Table 14 Conditional relationship definition

Field Description

Database Choose the database to which the WHERE clause applies. 
You can have a different WHERE clause for as many of the 
vendors and versions as necessary. For example, you could 
associate a different WHERE clause with SQL Server, 
Oracle 8i, and Oracle 9i. At runtime, HP Test Data 
Management can determine the database vendor and 
version, and apply the clause that you assigned to that 
vendor and version.

• Choose Any for the default WHERE clause. The Any 
WHERE clause is used for any vendor and version for 
which does not have an assigned WHERE clause. For 
example, if you do not assign a WHERE clause to Oracle 
or any of its versions, the Any WHERE clause will be 
used when deploying against Oracle.

• If the clause has vendor or version specific calls or 
syntax in it, expand the Any node until you see the 
necessary option for the clause and select it.

WHERE Type or edit the WHERE clause.

Columns Double-click the column name to insert the name into the 
WHERE clause. 

<<Insert Alternatively, highlight a column and use the <<Insert 
button to move it to the WHERE clause.
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Managing associated tables

If the WHERE clause for a conditional relationship or rule refers to tables that are 
not included in the model, you need to include such tables as associated tables. In 
Designer, you click Associated Tables and add these tables to the list. For tables in 
the associated tables list, a GRANT SELECT is automatically issued to ensure 
that they are accessible to the cartridge when it is deployed.

1 From the Rule dialog box or Conditional Relationship page, click Associated 
Tables. The Associated Tables List dialog displays.

2 You can populate the list in one of two ways:

a Click Automatic. Designer discovers the tables referenced in your 
WHERE clause that are outside the model and adds them to the list.

or

a Click Add. The Add Tables dialog box appears.

b Scan or search the tree to find the tables and select them.

c After you have selected the tables, click OK.

TIP To remove tables from the Associated Tables List dialog, select the table 
and click Remove.

3 Click OK.

Working with rules

A rule is a condition defined by a SQL WHERE clause that determines whether an 
object is eligible for copying. Typically, you define rules in the model and then 
select the model for use in a cartridge. In the case of a schema-based cartridge, 
where you have no model, a rule may be both defined and used in the cartridge.

When you create the rule, you specify whether it applies to copying data or 
specify that a rule only be used for Designer preview. For example, you may want 
to limit the scope of data during development to speed performance for frequent 
preview operations.
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Rules can be defined as exclusive or inclusive. With exclusive rules, all rows in 
the model instance must meet the defined criteria. With inclusive rules, only one 
row must meet the criteria. For example, for the following model instance 
orders1, you could define a rule to find orders with items that are equal to abc: 

This section includes: • Adding a rule (page 51)

• Editing a rule (page 54)

Adding a rule

1 Open a model. 

2 Right-click a table and select Add Rule.

The Rule dialog opens.

Table 15 Rule types

If the rule type is Effect

Exclusive The entire model instance orders1 is excluded because 
item2 and item3 do not meet the criteria to be extracted. All 
item rows must have a product of ‘abc’.

Inclusive The entire model instance orders1 is included because at 
least one item (item1) meets the criteria to be extracted. 
Inclusive rules must be associated with a driving table.
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3 Type or select values for the following fields: 

Table 16 Rule definition

Field Description

Name Type a name for the rule. 

The name cannot contain single quotes.

Usage Choose from the list of options:

• Extract means that the rule applies to extraction 
operations.

• Preview means that the rule applies only when 
previewing data in Designer. This type of rule is useful 
for limiting the data returned to improve performance 
during development.

Type Choose from the list of options:

• Exclusive means that, for any parent row to be eligible, 
all of its child rows must meet the defined criteria.

• Inclusive means that, for any parent row to be eligible, 
only one of its child rows must meet the defined criteria. 
Inclusive rules must be associated with a driving table.

Customization Choose from the list of options:

• Optional

• Mandatory

• Recommended

Refer to Guidelines for customizations (page 120) for more 
information about customization.

Eligibility
Analytics

Choose whether you want eligibility analytics to be enabled. 
Because eligibility analytics can impact the performance of 
a cartridge or business flow, you can choose to enable or 
disable them on a per rule basis.

By default, eligibility analytics are turned off and you must 
explicitly enable them.
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4 Optionally, click Parameters to create or edit parameters. Refer to Chapter 4, 
Working with parameters for more information about parameters.

5 Click OK.

Database Choose the database to which the WHERE clause applies. 
You can have a different WHERE clause for as many of the 
vendors and versions as necessary. For example, you could 
associate a different WHERE clause with SQL Server, 
Oracle 8i, and Oracle 9i. At runtime, HP Test Data 
Management can determine the database vendor and 
version, and apply the clause that you assigned to that 
vendor and version.

• Choose Any for the default WHERE clause. The Any 
WHERE clause is used for any vendor and version which 
does not have an assigned WHERE clause. For example, 
if you do not assign a WHERE clause to Oracle or any of 
its versions, the Any WHERE clause will be used when 
deploying against Oracle.

• If the clause has vendor or version specific calls or 
syntax in it, expand the Any node until you see the 
necessary option for the clause and select it.

WHERE Type or edit the WHERE clause. If you use subqueries, you 
should fully qualify column names to ensure that they are 
distinct from the columns in the outer query.

Parameters 
and Columns

Highlight a parameter or column and use the <<Insert button 
to move it to the WHERE clause.

<<Insert Use to move a highlighted parameter or column to the 
WHERE clause.

Parameters Click Parameters to manage your parameter definitions (add 
or edit parameters). Refer to Chapter 4, Working with 
parameters for more information.

Annotation Optionally, click this button to enter a description or 
comment for the rule. Refer to Annotating projects 
(page 21) for more information.

Validate Click Validate to verify that the syntax of your WHERE 
clause is correct. Note that validation does not ensure that 
your rule will behave as you expect. It simply confirms that 
it meets the syntax requirements of a WHERE clause for the 
database you are using.

Associated Tables Refer to Managing associated tables (page 50).

Table 16 Rule definition

Field Description
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Editing a rule

1 Open a model in Designer. 

2 Double click on a rule, or right-click a rule and select Edit Rule. The Rule 
dialog box opens. 

3 Edit the rule as appropriate. 

Working with virtual unique and foreign keys

A virtual unique key is the equivalent of a database unique key. A virtual foreign 
key is similar to a database foreign key but may also define the condition under 
which the relation is valid. Virtual unique and foreign keys are created in Designer 
when you add tables to a model, or from the Virtual Constraints dialog box. Once 
you create the virtual unique or foreign key, it becomes referenceable and 
available when you add tables in Designer. Virtual unique and foreign keys are not 
created in the database, and are not deployed to the database.

Typically, you would only create the virtual unique or foreign key prior to adding 
the table if you knew that you would need to use it repeatedly.

When working with virtual unique and foreign keys, you should be aware of the 
following restrictions:

• Because virtual unique and foreign keys are not validated, ensure that the ones 
you select are correctly defined.

• To ensure optimal performance, you should consider creating an index for any 
column that you plan to use as part of a virtual unique or foreign key. 
Otherwise, your extracting performance may be slow. A non-unique backing 
index or a unique index that covers some of the columns in the key may be 
sufficient to ensure good performance.

This section includes: • Adding a virtual unique key (page 54)

• Adding a virtual foreign key (page 55)

• Editing a virtual unique key or virtual foreign key (page 58)

• Deleting a virtual key (page 58)

Adding a virtual unique key 

1 Open a model. 

2 Right click a table and select Virtual Constraints. The Virtual Constraints 
dialog box opens. 

3 Click Add Unique Key. The Virtual Unique Key dialog box opens.
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4 Type or select the following:

5  Click OK. 

6 Click Close to close the Virtual Constraints dialog box.

Adding a virtual foreign key

1 Open a model. 

2 Right click a table and select Virtual Constraints. The Virtual Constraints 
dialog box opens. 

3 Click Add Foreign Key. The Add Virtual Foreign Key dialog box opens.

4 Type a string or a partial string in the Filter field to choose a table from which 
you will select a database or virtual unique key that corresponds to the virtual 
foreign key you are creating. Note that, if no unique key exists, the wizard 
walks you through creating one.

5 Click Search. 

6 Highlight the table you want. 

7 Click Next. 

The Specify How to Use or Build Keys page opens. If the chosen table has no 
unique keys (database or virtual), the page appears with only the two bottom 
radio buttons.

Table 17 Virtual unique key definition

Field Description

Name The default name of the key. You can accept it or type a 
new name.

Available Columns These columns in the tables could be used to define the 
key. Highlight values in the Available Columns table. 
Use the shuttle buttons to move columns back and forth 
from the Available Columns and Key Columns lists as 
necessary.

Key Columns These columns are the ones selected to define the key. 
Highlight values in the Key Columns table. Use the 
shuttle buttons to move columns back and forth from 
the Available Columns and Key Columns lists as 
necessary.

Shuttle buttons (>,<) Use Shuttle buttons to move columns back and forth 
between Available Columns and Key Columns.

Up and Down buttons Use to order the columns in the Key Columns list.

Sort Displays the Available Columns in alphabetical order.
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8 Choose one of the following radio buttons: 

9 Use the Unique Key page to define a new unique key: 

10 Click Next. 

Table 18 Key specification

Selection Description Next steps

Create a new 
foreign key 
associated with the 
following unique 
key or index

This option creates a new 
foreign key using existing 
unique key.

• Highlight an existing 
unique key to be used 
with the new foreign 
key.

• Click Next.

• Continue with step 11.

Create a new 
unique key and 
foreign key

This option creates a new 
unique key and then a new 
foreign key that uses the just 
created unique key.

• Click Next. 

• Continue with step 9.

Create a new 
foreign key based 
only on a 
conditional 
relationship

If the chosen table has no 
unique key, you can create a 
foreign key based entirely 
on a relationship filter.

• Click Next.

• Define a condition for 
the virtual foreign key.

• Click Finish.

Table 19 Unique key definition

Field Description

Name The default name of the key. You can accept it or type a 
new name.

Available Columns These columns in the tables could be used to define the 
key. Highlight values in the Available Columns table. 
Use the shuttle buttons to move columns back and forth 
from the Available Columns and Key Columns lists as 
necessary.

Key Columns These columns are the ones selected to define the key. 
Highlight values in the Key Columns table. Use the 
shuttle buttons to move columns back and forth from 
the Available Columns and Key Columns lists as 
necessary.

Shuttle buttons (>,<) Use Shuttle buttons to move columns back and forth 
between Available Columns and Key Columns.

Up and Down buttons Use to order the columns in the Key Columns field.

Sort Sorts the Available Columns in alphabetical order.
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11 Use the Foreign Key page to define a new foreign key: 

12 Click Next. 

13 Optionally, use the Conditional Relationship page to define a SQL clause to 
filter the relationship. 

Table 20 Foreign key definition

Field Description

Name Accept or type a new name for the key.

Available Columns Highlight values in the Available Columns table. Use 
Shuttle button (>) to move columns from Available 
Columns to Key Columns.

Key Columns Highlight values in the Key Columns table. 
Double-click or use Shuttle buttons to move columns 
from Available Columns to Key Columns or back again.

Shuttle buttons (>,<) Use Shuttle buttons to move columns back and forth 
between Available Columns and Key Columns.

Up and Down buttons Use to order the columns in the Key Columns field.

Sort Sorts the Available Columns in alphabetical order.

Table 21 Conditional relationship definition

Field Description

Database Choose the database to which the WHERE clause applies. You 
can have a different WHERE clause for as many of the vendors 
and versions as necessary. For example, you could associate a 
different WHERE clause with SQL Server, Oracle 8i, and Oracle 
9i. At runtime, HP Test Data Management can determine the 
database vendor and version, and apply the clause that you 
assigned to that vendor and version.

• Choose Any for the default WHERE clause. The Any WHERE 
clause is used for any vendor and version for which does not 
have an assigned WHERE clause. For example, if you do not 
assign a WHERE clause to Oracle or any of its versions, the 
Any WHERE clause will be used when deploying against 
Oracle.

• If the clause has vendor or version specific calls or syntax in it, 
expand the Any node until you see the necessary option for the 
clause and select it.

WHERE Type or edit the WHERE clause.
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14 Click Finish. 

15 Click Close to close the Virtual Constraints dialog box.

Editing a virtual unique key or virtual foreign key

1 Open a model. 

2 Right click a table and select Virtual Constraints. The Virtual Constraints 
dialog box opens.

TIP You can also right-click a line in the model and choose Edit Virtual 
Foreign Key.

3 Select a virtual constraint from the list. 

4 Click Edit.

5 Edit the virtual unique key or virtual foreign key as required.

6 Click OK.

7 Click Close to close the Virtual Constraints dialog box.

Deleting a virtual key

1 Open a model. 

2 Right click a table and select Virtual Constraints. The Virtual Constraints 
dialog box opens. 

TIP You can also right-click a line in the model and choose Replace Virtual 
Foreign Key Connection, if you want to simply change the selected foreign 
key for the relationship.

3 Select a virtual constraint from the list. 

4 Click Remove.

Columns Double-click the column name to insert the name into the 
WHERE clause. 

<<Insert Alternatively, highlight a column and use the <<Insert button to 
move it to the WHERE clause.

Associated 
Tables

Refer to Managing associated tables (page 50).

Table 21 Conditional relationship definition

Field Description
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Modifying object properties

Object properties allow you to change the name of an object in the model. For 
example, you can rename a database table to something that is more meaningful to 
you for the creation of your cartridge.

This feature also allows you to set aliases and add annotations to the object. 

1 Right-click a table use in the model and select Properties. 

2 Modify the properties as you want. 

Locating a table

This feature helps you locate model tables in the database navigator. If your 
database has many tables, you can use this feature to quickly find a table so that 
you can browse its details.

1 Right click a table in the model editor or under the Model node in the Project 
Navigator and select Locate Table.

The table is selected in the database navigator.

Drag and drop a table

This feature allows you to drag a table from the database navigator and attach it to 
any existing table in the model.

1 Highlight a table in the database navigator panel.

2 Drag the table over to the Model editor.

Table 22 Object properties

Property Description

Table Name The name of the table in the database. If you have 
mapped schemas through Connection > Map Schemas, 
you will see Mapped Table Name and Database Table 
Name instead of just Table Name.

Shape Name The name you want displayed in the diagram. This 
name has no impact on the cartridge. It is for display 
purposes in the diagram only.

Table Alias The alias to be used in rule WHERE clauses. (Changing 
the name will invalidate any existing rules that 
reference the previous alias.)

Data Movement Key Select the Data Movement Key you want to use for the 
object. This key is used to join to the selection tables.
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3 Drop the table on any existing table.

4 Select one of the following:

— add <table_name> as a transactional table

— add <table_name> as a lookup table

— add <table_name> as a chaining table

5 From this point, the wizard behaves much the way it is described in the 
following sections, except it does not display the Choose Table page because 
the parent and child are already known to it.

— Adding transactional tables (page 32)

— Adding lookup tables (page 39)

— Adding chaining tables (page 45)
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4 Working with parameters
In HP Test Data Management, you can use parameters in your rules, allowing 
users who run the jobs to change the values at runtime. In addition, you can create 
parameters that can be given values dynamically at runtime by code or at 
configuration time by administrators.

This chapter explains how to work with parameters.

This chapter includes: • About parameters (page 61)

• Creating parameters (page 62)

• Validating parameters (page 66)

• Creating lists of values for parameters (page 67)

• Referencing parameters (page 69)

• Managing model compatibility (page 73)

• Deleting parameters (page 73)

About parameters

In HP Test Data Management, you have three types of parameters:

• Runtime parameters have their values set at runtime by the user running the 
job. Runtime parameters tend to be best for operational values that tend to 
change with each execution of a job. For example, if your extraction is based 
on a specified cutoff date, you most likely need to update that date every time 
you run the job.

• Configuration parameters have their values set by an administrator 
(someone who has repository privileges from Console) through the 
administrator interface. Typically, this type of parameter represents values 
that should be changed very infrequently, perhaps only at deployment time.

• Dynamic parameters have their values set once by a Groovy script that runs 
at deployment time to obtain a value. For example, this type of parameter can 
supply the type or version of a database or application, which can be obtained 
programmatically at deployment time.

NOTE Once a job starts running in the Web Console, all three types of parameters 
are treated the same way. In addition, you cannot change the parameter values 
after the job starts.
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Regardless of a parameter’s type, it can be referenced from several places within 
your extraction project:

• WHERE clauses within your rules

• Groovy scripts in runtime and configuration parameter validations

• Groovy scripts in business flows 

• SQL for runtime and configuration parameter list of values

• Interrupts in your business flows

• Manage Compatibilities dialog box for the model (dynamic parameters only)

Creating parameters

You can create parameters beforehand and then reference them, or, in SQL, you 
can create them dynamically as you reference them.

This section includes: • Creating or editing parameters from the Project Navigator (page 62)

• Creating or editing parameters using the Parameters button (page 65)

• Creating parameters automatically (page 65)

• Validating parameters (page 66)

Creating or editing parameters from the Project Navigator

1 In Designer, from the Project Navigator, right-click the Parameters node and 
choose New Parameter.

2 Type or select values for the following Parameter definition properties:  

Field Description

Name Enter a name for the parameter. In choosing parameter names, you 
must avoid reserved names. Refer to Validating parameters 
(page 66) for a list of reserved names.

Parameter 
Type

Type of the parameter, choose one from the list of options:

• Runtime parameters get their values from the user at runtime.

• Configuration parameters are assigned values by the 
administrator and cannot be changed by the user at runtime.

• Dynamic parameters get their values from Groovy scripts. If you 
choose this type, the rest of the properties in the dialog are 
replaced by Data Type and a Code area, where you can enter 
your Groovy script.

Label Label that appears on the Console Job Launcher page.

Data Type Type of the parameter’s value (Date, Number, or String).
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Length Maximum length allowed for the selected data type.

Default Type a default parameter value.

Field Description
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Validation For runtime and configuration parameters only, the type of 
validation you want to use for the parameter’s values. Choose from 
the list of options:
• None

• Groovy means that you will supply a Groovy script to validate 
the parameter’s value. 

• Mandatory means that a parameter value must be supplied in 
order for the job to run.

Refer to Validating parameters (page 66) for more information.

List of 
Values

For runtime and configuration parameters only, the kind of list of 
values you want to use. Choose from the list of options:
• None

• Static means that you can use the adjacent browse button to 
create a hard-coded list of values for the parameter.

• SQL means that a SQL SELECT statement populates the list of 
values for the parameter.

Refer to Creating lists of values for parameters (page 67).

Code 
(dynamic 
parameters 
only)

This area only appears when you choose a Parameter Type of 
Dynamic. Enter a Groovy script that populates the parameter’s 
value. The code must return a value that matches the parameter’s 
data type (Date, Number, or String). For the date data type, you 
must use java.util.Date to return a value of the appropriate type 
and format. For the number and string data types, the code must 
return number or string values, respectively.

If you are planning to use the parameter for compatibility checking, 
it must return a string. Refer to Managing model compatibility 
(page 73) for more information about compatibility.

An example of a Groovy script that populates a dynamic parameter 
might look like the following:

 import java.util.Date

 import org.codehaus.groovy.runtime.TimeCategory;

 use([TimeCategory]) {

   Date now = new Date();

   Date cutoff_dt = now – retention.months

   // Adjust the date to the beginning of the year.

   GregorianCalendar calendar = new 
GregorianCalendar();

   calendar.setTime(cutoff_dt);

   calendar.set(GregorianCalendar.MONTH, 0);

   calendar.set(GregorianCalendar.DAY_OF_MONTH, 1);

   return calendar.getTime();

 }

where retention is a configuration parameter.

Field Description
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3 Click OK.

Creating or editing parameters using the Parameters button

1 In Designer, from either the Rule or Groovy Script dialogs, click Parameters.

2 To create a new parameter, click Add. To edit an existing parameter, click it in 
the list on the left of the dialog.

3 Type or select values for the fields as described in step 2 (page 62).

In choosing parameter names, you must avoid reserved names. Refer to 
Validating parameters (page 66) for a list of reserved names.

4 Click OK.

5 To reference the parameter, refer to Referencing parameters (page 69).

TIP To delete a parameter, right-click it in the Project Navigator under the 
Parameters node and choose Delete. When you delete a parameter, ensure that you 
also delete all references to it throughout your project.

Creating parameters automatically

1 In Designer, referencing a parameter in SQL that does not already exist causes 
a new parameter to be automatically created with default properties. Refer to 
Referencing parameters (page 69) for information on how to reference 
parameters.

2 After you reference the new parameter from SQL, go to the Project Navigator 
and expand the Parameters node to find the automatically created parameter.

TIP Some dialog boxes, such as the Rule dialog box, contain a Parameters 
button, which you can click to see the parameters as well. If you’re not in such 
a dialog, you need to accept the dialogs and go to the Project Navigator.
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3 Double-click the automatically created parameter. Confirm that its properties 
are appropriate for your usage. Refer to step 2 (page 62) for more information 
about parameter definition properties.

4 Click OK.

Validating parameters

For runtime and configuration parameters, you can choose whether and how to 
validate the values entered by the user. By validating parameters, you ensure that 
the user enters a valid value before attempting to run the business flow that 
references the parameter. If the user enters an invalid value, the job will not run. If 
you choose not to validate parameter values, then an invalid value is not 
discovered until the job fails.

1 Go to the Parameter Definition dialog box by right clicking the parameter in 
the Project Navigator and choosing Edit Parameter.

2 In the Validation field, choose one of these values:

— None means that you want no validation performed on parameter values.

— Mandatory means that a value must be entered for the parameter in order 
for the business flow to run. If a value is not entered, then the business 
flow will not run. In general, if you choose Mandatory, it is good practice 
to also enter a default value for the parameter. That way, if the user does 
not enter a value, the business flow will run with the default value rather 
than fail.

— Groovy means that you are providing a Groovy script to check the value. 
If you choose this option, you must also click the adjacent browse button 
to create a Groovy script. If the parameter fails validation, the script must 
return a short error message that describes the reason for the validation 
failure. If the parameter passes validation, the script must return nothing, 
or a null or empty string. An example Groovy validation script might look 
something like the following:

Example   import java.util.Date
  import org.codehaus.groovy.runtime.TimeCategory;
  use([TimeCategory]) {
   Date now = new Date()
   Date maxDate = now - retention.months
   if (cutoff_dt > maxDate){
    return "Date must be older than ${retention} months."
   }
  }

where cutoff_dt is a runtime parameter and retention a configuration 
parameter
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Creating lists of values for parameters

Lists of values for runtime and configuration parameters provide another method 
for reducing the likelihood of user input errors and restricting the possible values 
the user may enter. You can create a fixed list of values by manual entering values 
and labels. Alternatively, if the possible values are stored in a database table 
somewhere, you can create a dynamic list of values by using a SQL SELECT 
statement to populate the list. The latter option tends to be the most efficient 
method because it ensures that the list of values will be automatically kept in sync 
with the database. You do not have to worry about updating the list every time the 
possible values change.

TIP Lists of values do not apply when you run your business flow from the 
command line. To restrict the values entered from the command line, you should 
use validation Groovy scripts. Refer to Validating parameters (page 66).

Creating a static list of values

1 Go to the Parameter Definition dialog box by right clicking the parameter in 
the Project Navigator and choosing Edit Parameter.

2 In the List of Values field, choose Static.

3 Click the Browse button to the right of List of Values.

4 For Id, enter a valid value for the parameter.

5 For Label, enter the label that you want the user to see in the list. For example, 
suppose the parameter values are the start and close dates of quarters in your 
fiscal years. For Label, you might enter something like Q1FY08 Start or 
Q1FY08 Close.

6 Click Add.

7 Repeat step 4 through step 6 until you have added all of the desired values to 
the list.

8 Click OK.

Creating dynamic lists of values

1 Go to the Parameter Definition dialog box by right clicking the parameter in 
the Project Navigator and choosing Edit Parameter.

2 In the List of Values field, choose SQL.

3 Click the Browse button to the right of List of Values. The Dynamic List 
Definition dialog box displays.
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4 For Database Connection, choose the connection (Source, Repository) 
against which you want to run the SELECT statement that populates the list.

5 Choose either the Drop-Down List or Look-Up List radio button. A drop-down 
list shows the list of values as a combo box with the field. A look-up list opens 
a dialog with the values and the user can enter a filter pattern.

TIP If you choose Look-Up List, notice that a parameter named FilterPattern 
appears in the Parameters area. This parameter contains the search string 
entered by the user and you can reference this string from your SELECT 
statement. For example, you might use this string to further qualify your 
SELECT criteria and thereby reduce the size of the list.

Use a drop-down list if the number of values is reasonably small. Use a 
look-up list of the number of values is very large.

6 For Database, choose the database to which the SELECT statement applies. 
You can have a different SELECT statement for as many of the vendors and 
versions as necessary. For example, you could associate a different SELECT 
statement with SQL Server, Oracle 8i, and Oracle 9i. At runtime, HP Test 
Data Management can determine the database vendor and version, and apply 
the clause that you assigned to that vendor and version.

— Choose Any for the default WHERE clause. The Any WHERE clause is 
used for any vendor and version which does not have an assigned 
WHERE clause. For example, if you do not assign a WHERE clause to 
Oracle or any of its versions, the Any WHERE clause will be used when 
deploying against Oracle.

— If the clause has vendor or version specific calls or syntax in it, expand 
the Any node until you see the necessary option for the vendor and 
version and select it.

7  For SQL, enter a SQL SELECT statement that populates the list of values for 
the parameter. The SELECT statement must return an id and a label. The id 
is the first return value, it will appear on the command line. Note that the data 
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type of the id sets the data type for the parameter. The label is the second 
return value. It is displayed to the user in the drop-down list or look-up list in 
the Job Launcher in the Console.

See Examples (page 69) for some SQL examples for your list of values.

8 Click Validate to confirm the syntax of your SELECT statement.

TIP If you are using Neoview with a UCS2 configuration and your SELECT 
statement contains a bind variable, clicking Validate may throw a character set 
error. To avoid this error, you can wrap the variable with a translate function, 
for example, where b.name = translate(:variable using 
ISO88591TOUCS2).

9 If you reference tables not included in your model, click Associated Tables.

See also Managing associated tables (page 50)

10 Click OK.

Examples Following is an example SELECT statement with numeric values:

SELECT CUSTOMER.CUSTOMERID, CUSTOMER.LASTNAME
   || ' ' || CUSTOMER.FIRSTNAME
FROM CUSTOMER
WHERE CUSTOMER.CUSTOMERID IN (
    SELECT ORDER_HEADER.CUSTOMERID
    FROM ORDER_HEADER
    WHERE ORDER_HEADER.ORDERDATE < :cutoff_dt
    )
ORDER BY 2

where cutoff_dt is a runtime parameter.

Following is an example SELECT statement with date values:

SELECT TO_CHAR(SHIPDATE, 'YYYY.MM.DD') , 
TO_CHAR(SHIPDATE, 'DD-MON-YYYY')
FROM ORDER_HEADER

NOTE For the id (the first value in the SELECT statement), you must format 
the date value. For label, the formatting is optional. Note that Oracle 
requires MMM rather than MON.

Referencing parameters

You can reference parameters in your project by:

• In Designer, inside SQL, typing :parameter_name. For example, the 
WHERE clause in a rule might reference a parameter named 
Min_Months_to_Retain as follows:

add_months("ORDER_HEADER".SHIPDATE, 
:Min_Months_to_Retain)<sysdate
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NOTE In SQL, if the parameter does not already exist, HP Test Data 
Management creates a parameter with default properties for you. Refer to 
Creating parameters automatically (page 65) for information on how to 
handle automatically created parameters.

• In Designer, inside a Groovy script, typing parameter_name.

System parameters

Table 23 lists the system parameters built into HP Test Data Management, which 
you can reference within your projects.

NOTE The system parameter names are reserved and you cannot create your own 
parameters with these names. Hence, when you reference a system parameter 
name, such as FilterPattern, Designer will not create a new parameter. It 
assumes that you meant to reference the system parameter instead.
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Table 23 System parameters

Parameter Name Data type Description

BUSINESS_FLOW_NAME STRING Referenceable from: Groovy 
activity

This parameter is the name of 
the business flow being run. 
This parameter is useful when 
querying the HP Test Data 
Management repository. It 
holds values such as Orders_BF 
or emp_BF.

CURRENT_GROUP_RUN_ID NUMBER Referenceable from: Groovy 
activity

This parameter is the group 
identifier for the job at runtime. 
This parameter is useful when 
querying the HP Test Data 
Management repository. It 
holds values such as 1, 22, 34, 
or 42.

CURRENT_RUN_ID NUMBER Referenceable from: Groovy

This parameter is the identifier 
for the job at runtime. This 
parameter is useful when 
querying the HP Test Data 
Management repository. It 
holds values such as 1, 22, 34, 
or 42.

FilterPattern STRING Referenceable from: SQL 
popup list of values

This parameter is the value 
entered by the user in the list of 
values. You can use this 
parameter to narrow your list of 
values based upon what the user 
has entered.

Note that this parameter only 
provides the value entered by 
the user in the list. It does not 
append any special characters 
like % or *.
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Symbolic schema names

When specifying the schema name of tables, you can use symbolic notation for 
the schema names rather than hard coding the actual names. These symbolic 
schema names are valid in SQL fields (for example, in a rule) or Groovy scripts. 
Furthermore, any schema mappings you have created in Designer are also applied 
to these tokens.

For queries against the active database:

${SOURCE.<source_schema_name>.ORDER_HEADER}

For queries against the database from which you are copying data:

${FROM.<source_schema_name>.ORDER_HEADER}

INTF_DB groovy.sql.Sql Referenceable from: any 
Groovy

This parameter is the database 
connection for the interface 
schema.

OBT_INTF_DBTYPE groovy.sql.Sql Referenceable from: any 
Groovy

This parameter is the database 
type, for example, Oracle, SQL 
Server, or Sybase.

OBT_INTF_DBVER groovy.sql.Sql Referenceable from: any 
Groovy

This parameter is the database 
version, for example, 10g, 11g, 
2008, 12.5, or 2.5.

REPOS_DB groovy.sql.Sql Referenceable from: Groovy

This parameter is the database 
connection for the repository. 
You can use it to connect to the 
repository database where HP 
Test Data Management stores 
its metadata.

Table 23 System parameters

Parameter Name Data type Description
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Managing model compatibility

Each model in your project can have one or more dynamic parameters associated 
with it to verify the compatibility with the extraction environment. If the 
parameter returns a string of false, then the cartridge referencing the model will 
not deploy or run and throw an error. For example, the script for the dynamic 
parameter could return false for Oracle 10.2 and true for Oracle 11.1 to indicate 
that a cartridge referencing the model can only deploy and run against Oracle 
11.1.

To choose dynamic parameters for the evaluation of model compatibility:

1 In the Project Navigator, right click a model node and choose Manage 
Compatibilities.

2 In the list, select the dynamic parameters that you want to use for model 
compatibility. Note that only dynamic parameters appear in the list. If the list 
is empty, then you do not have any dynamic parameters. The parameter must 
return a string of true or false.

3 Click OK.

Deleting parameters

Before you delete a parameter, you must ensure that you understand and remove/
replace all references to that parameter throughout your project.

1 In Designer, find all references in SQL and Groovy to the parameter you wish 
to delete and remove or replace those references. If you do not remove all 
references to the parameter prior to deleting it, it will break any SQL or 
Groovy that references it.

2 In the Project Navigator, expand the Parameters node.

3 Right click the parameter you wish to delete and select Delete. 
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5 Previewing models and cartridges
Preview is a function of Designer used to view the data eligible for copying in 
your model and cartridge. Preview enables you to confirm that your model or 
cartridge is behaving as expected before you deploy and run it.

This chapter includes: • About preview (page 75)

• Creating preview rules (page 76)

• Previewing models and cartridges (page 76)

About preview

Preview provides a quick way to test your test data solution as you are building it. 
You need not wait until you deploy and run your cartridge to see if the model and 
cartridge work properly. It is best practice to preview your test data solution at 
each stage of development and preview it repeatedly until you are certain it 
performs as expected.

For example, you can preview your model before you create any rules and then 
preview it again after you add each rule. Preview identifies the rows that are 
excluded as well as which rule causes their exclusion. When you create your 
cartridge, you can preview its behavior as well.

With preview, you can determine: 

• What data meets the criteria defined by the rules. You can choose at runtime 
which rules to enforce for that execution. In this way, you can check each rule 
by itself as well as in combination with the other rules.

• What data is excluded. Preview displays rows that would be excluded from 
the extraction in red.

• Which rules prevent certain data from being extracted. In preview, a column 
called Excluded By shows the name of the rule that excluded a particular row. 
If a row is included, this column is blank for that row.

You can run preview against models and cartridges with eligibility analytics on or 
off, and with any combination of rules applied. If you see differences between the 
preview for a model and a cartridge based on that model, it is most likely because 
the cartridge is not using the same combination of rules as the model. 

If your model contains chaining logic, the data retrieved by preview will differ 
from the data that will be selected for extraction by the cartridge.

If you have a large amounts of data and are frequently previewing, you can create 
rules that are Preview Only to improve performance.
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Creating preview rules

When in the development phase for your test data solution, a quick response time 
is helpful because you are frequently making model enhancements and 
previewing them. Limiting the data returned for testing purposes is often 
worthwhile. A preview rule enables you to define a rule that applies only in 
preview in Designer. The rule is not applied when you generate and deploy your 
cartridge for actual usage.

To create a preview rule:

1 Right click a table in the model and select Add Rule from the pop-up menu.

2 For Usage, select Preview Only.

3 Define the other properties for your rule. For example, in Oracle, you might 
enter a WHERE clause such as this one to limit the number of rows returned:

ORDER_ID in (100, 132, 5540)

4 Click OK.

5 Click Preview in the toolbar to confirm that fewer rows are returned in the 
Preview tab.

Previewing models and cartridges

1 Open a model or cartridge in Designer. 

2 Click Preview in the tool bar. 

3 In the Parameters Values window, check the rules to apply and uncheck those 
to ignore for this run.

4 If you have any parameters, type/choose the values in the Parameter Values 
window.

5 Check or uncheck Eligibility Analytics for all rules, depending upon whether 
you want them. 

When checked, Designer creates analytics for each rule, regardless of what is 
set for the individual rules in the Rule dialog box. Enabling analytics causes 
the ineligible data to appear in red in the preview.
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6 Click OK.

The Preview pane opens.

 

— The top part of the window shows the rows of the driving table. Select a 
row or range of rows in the top part of the window to filter the rows 
displayed in the bottom part. Use Ctrl-click to select more than one row or 
clear the rows selected.

— The Excluded By column displays the rule that caused a row to be 
excluded. All rows that are excluded are displayed in red.

— Click on column headers to sort the rows by that value. For example, if 
you click the Excluded By column header, the rows are sorted according 
to the values of that column.

— Click and drag the column borders to resize the columns in the display.

— The model structure, including rules, is displayed in the lower left pane. 
Expand and collapse the node to view the tables and rule you want. 
Positive numbers in parentheses next to the driving table indicate the 
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number of driving table rows included by that table. Negative numbers in 
parentheses next to a rule indicate the number of driving table rows 
excluded by the rule.

7 If you want to export the contents of the top table to a comma delimited file, 
right click a row and choose Export Data. If you want to export the contents 
of the bottom table to a comma delimited file, right click on a table node in the 
lower left pane and choose Export Details Data.

8 Click Refresh from the toolbar to refresh the data from the database.

9 When you are done with this instance of preview, click the Close icon on the 
tab.
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6 Working with cartridges
After you have your model and rules defined, you must consider how to deploy 
that solution for copying data to your structured data file. A cartridge is an 
instance of model- or schema-based eligibility criteria used to copy data from one 
location to another. The cartridge enables you to specify a set of characteristics to 
apply to a particular data movement activity.

This chapter includes: • About cartridges (page 79)

• Creating a new cartridge (page 79)

• Editing a database to file cartridge (page 80)

• Editing a schema-based database to file cartridge (page 85)

• Applying data masks (page 90)

• Deleting cartridges (page 99)

About cartridges

HP Test Data Management has types of cartridges:

• Database to file cartridges copy data from a database to a structured file in 
either XML or comma separated values (CSV) format.

• Schema-based database to file cartridges extract data from a specified set of 
tables (without use of a model) to a file (XML or CSV). Schema-based 
cartridges are useful when you simply want to extract a set of tables without 
specifying relationships between them (no model).

Creating a new cartridge

1 Select Cartridges in the Project Navigator, or select an existing model or 
cartridge.

2 Right click and select New Cartridge. 

3 Type a name for the Cartridge. Example, salesorder. 

The name you select appears in the Deployment Assistant and in the Web 
Console.

4 For Type, select Database to File.
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5 For Source, choose Schema or Model. For information about the difference 
between schema-based and model-based movement, refer to About cartridges 
(page 79).

6 If you chose Model in the previous step, select a model from the list. 

7 Click OK to create your new cartridge. 

The cartridge opens in the editor. 

8 Edit the values. For more information, refer to the following sections:

— Editing a database to file cartridge (page 80).

— Editing a schema-based database to file cartridge (page 85)

TIP You can make annotations from each tab of the cartridge editor according to 
the behavior described in Annotating cartridges (page 22).

Editing a database to file cartridge

The database to file cartridge editor consists of the following tabs: 

• Overview

• Operations

• Data Masking

• File Indexes

• Column Inclusion

• Name Override

• Custom Properties

You can edit the information on each tab at any point during the cartridge editing 
process, as well as edit the model that is associated with the cartridge. 

1 Expand Cartridges in the Project Navigator window. 

2 Select the database to file cartridge that you want to edit.

The Database to File Cartridge page opens in the editor.
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3 Type or select values for the following as necessary.

4 Select the Operations tab. The Edit Operations page opens.

5 Select the Data Masking tab. The Edit Data Masking page opens and you can 
apply data masks to particular columns as necessary to protect privacy or hide 
confidential information, such as Social Security Numbers and credit card 
numbers. Refer to Applying data masks (page 90).

6 Select the File Indexes tab. Use this tab to specify indexes for your files for 
your database to file cartridge. The primary benefit of the file index is that, 
once the data is extracted, you can easily discover what data is in which file. 
For example, if you create a file index on customer name, you can find out 
easily what files contain orders from a particular customer.

You cannot index LOB columns. Furthermore, if a column is indexed, it must 
also be included on the Column Inclusion tab.

See also HP Test Data Management Runtime guide

7 Select the Column Inclusion tab. The Edit Column Inclusion page opens.
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TIP If you indexed a column from the File Indexes tab, you cannot exclude it 
from the Column Inclusion tab.

Use this tab to specify how table columns are included or excluded by your 
cartridge. 

TIP Include All is not equivalent to selecting Include Columns and explicitly 
checking all columns. The former includes all columns found at deployment 
time. The latter only includes the columns you selected at development time. 
For example, if your development database contains only a subset of the 
columns in your production database, then selecting Include Columns with all 
columns checked may not extract all the columns in your production database.

8 Select the Name Override tab. The Edit Name Override page displays.

Table 24 Column inclusion options

Select To

Include All Copies all the columns found at deployment even if the 
column was not part of the table definition during the 
design of the cartridge.

Include Columns Ensure that only the columns you specify are copied by 
the cartridge.

Exclude Columns Ensure that specific columns are excluded from the copy. 
This option automatically copies all the other columns 
found at installation and their data, even if they were not 
part of the table definition during design of the cartridge.
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Use this tab to define the element names to be used in the XML file. By 
default the element names are identical to the table and column names.

The Name Override alters how a table or column name is represented in the 
XML document. A Name Override is necessary whenever a table or column 
name is not a valid XML element name, for example, multi-byte character 
sets (MBCS). 

NOTE If you create a name override for a column, the column is included in 
the XML output, regardless of whether you excluded the column on the 
Column Inclusion tab.

Related information See http://www.w3.org/TR/REC-xml/#NT-Name for information on valid 
XML element names.

a Expand the database in the Database Name list, and select a column or 
table name.

b Edit the value in the XML Name field so that the name is compatible with 
XML element naming conventions.

9 Select the Custom Properties tab.

10 In Custom Properties, you can optionally create, annotate, and delete 
name-value pairs that provide additional information about your data. Such 
information could be used by other applications to classify or otherwise 
operate on the data.

a Click New to create a new custom property.

b Enter a Name for the property.

c Enter a Value for the property.

d Click Annotation to add a comment to the property.

e Use the Delete button to get rid of the currently selected property, if you 
do not need it.

TIP Each tab of the cartridge editor has its own Annotation button to enable you to 
enter comments. Refer to Annotating projects (page 21) for more information.
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See also Generating and deploying (page 111) for information on generating and deploying 
your cartridge.

Output files

When you extract data to a file, you can extract it as XML or CSV files. The 
generated XML or CSV files are described in this section.

• XML output files (page 84)

• CSV output files (page 85)

XML output files

When you extract to XML, the following files are created: 

All the information needed to interpret the structure of the test data is contained in 
these files, making the XML stand-alone for many years to come.

File Description

summary XML Contains summary information about the extraction process 
that was run to create the files. This information includes: 

• what files were created

• what data was extracted

• where the data was extracted from

• how much data was extracted

summary XSD XML Schema Definition file that defines the structure and 
makeup of the summary XML file. 

group XML The group XML file contains the following information:

• information about the extraction process used to generate 
the extracted data within each particular XML file

• the extracted database data in XML form

The number of group XML files depends on the data 
movement batch size. For example, if you set the batch size to 
100, and there are 1000 driving table rows being extracted, 
then 10 group XML files are generated. Refer to the Runtime 
guide for more information.

group XSD XML Schema Definition file that defines the structure and 
makeup of the group XML file. 
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CSV output files

When you extract to CSV, the following files are created:

Editing a schema-based database to file cartridge

1 Expand Cartridges in the Project Navigator window. 

2 Select the schema-based database to file cartridge that you want to edit. The 
Database to File cartridge page opens in the editor.

File Description

summary XML Contains summary information about the 
extraction process that was run to create the 
files. This information includes: 

• what files were created

• what data was extracted

• where the data was copied from

• how much data was extracted

summary XSD XML Schema Definition file that defines the 
structure and makeup of the summary XML file.

group XML The group XML file contains a list of all of the 
CSV files for the group.

group CSV The group CSV file contains the extracted 
database data in CSV format.

Each group has a set of CSV files for each table 
use. For example, if you have 10 groups and 3 
table uses, you will have 30 group CSV files. 
Refer to the HP Test Data Management Runtime 
guide for more information.
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3 Type or select values for the following as necessary:

4 Click Add to display the Add Tables dialog box and select tables to be added 
to the extraction process.

5 Click OK.

6 If necessary, click Remove and select tables for removal. 

7 Select the Operations tab. The Edit Operations page opens.

Table 25 Overview properties

Field Description

Version Type a version number for the cartridge or 
accept the default.
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8 Select the Data tab.

9 Choose one of the radio buttons:

— All Data means that the table will be created in the test data store and 
populated with data.

— No Data means that only XSD files are generated. No data files are 
generated in this case. This option is useful in cases where you need the 
tables present in order for the application to run, but you do not 
necessarily need the data.

— Selected Data means that the table will be created in the test data store 
and a WHERE clause used to populate it with selected data from the 
active database. 
HP Test Data Management Developer’s guide 87



If you choose this radio button, type or select values for the following as 
necessary:

10 Select the Data Movement Key tab.

Table 26 WHERE clause for choosing data

Field Description

Database Choose the database to which the WHERE clause applies. You can 
have a different WHERE clause for as many of the vendors and 
versions as necessary. For example, you could associate a different 
WHERE clause with SQL Server, Oracle 8i, and Oracle 9i. At 
runtime, HP Test Data Management can determine the database 
vendor and version, and apply the clause that you assigned to that 
vendor and version.

• Choose Any for the default WHERE clause. The Any WHERE 
clause is used for any vendor and version which does not have 
an assigned WHERE clause. For example, if you do not assign a 
WHERE clause to Oracle or any of its versions, the Any 
WHERE clause will be used when deploying against Oracle.

• If the clause has vendor or version specific calls or syntax in it, 
expand the Any node until you see the necessary option for the 
clause and select it.

WHERE Type or edit the WHERE clause.

Columns Double-click the column name to insert the name into the WHERE 
clause.

Insert Alternatively, highlight a column and use the <<Insert button to 
move it to the WHERE clause.
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11 Choose an option from the Key list of values, the table’s primary key, other 
unique keys in the table, None, or Virtual Key. If you choose Virtual Key, you 
must specify the columns for the virtual key to use.

TIP For SQL Server, you cannot choose None because it requires a data 
movement key. 

12 Select the Data Masking tab. The Edit Data Masking page opens and you can 
apply data masks to particular columns as necessary to protect privacy or hide 
confidential information, such as Social Security Numbers and credit card 
numbers. Refer to Applying data masks (page 90).

13 Select the File Indexes tab. The Edit File Indexes page behaves similarly to 
the Edit File Indexes page for a database to file cartridge, Editing a database 
to file cartridge (page 80).
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14 Select the Column Inclusion tab. The Edit Column Inclusion page behaves 
similarly to the Edit File Indexes page for a database to file cartridge, Editing 
a database to file cartridge (page 80).

15 Select the Name Override tab. The Edit Name Override page behaves 
similarly to the Edit Name Override page for a database to file cartridge, 
Editing a database to file cartridge (page 80).

16 Select the Custom Properties tab. The Custom Properties page opens and 
behaves similarly to the Custom Properties page for a database to file 
cartridge, Editing a database to file cartridge (page 80).

Applying data masks

By applying a data mask to a column, you can obfuscate its values in the extracted 
data, thus protecting private, confidential information, such as credit card or social 
security numbers.

TIP Values are not masked for Designer preview. They are only masked when 
running the business flow outside of Designer from Web Console or command 
line.

HP Test Data Management provides pre-built masks for the data which most 
commonly requires protection, such as, credit card numbers and Social Security 
numbers. In addition, you can create your own, custom masks for data that you 
wish to mask.

1 In the cartridge editor, select the Data Masking tab. The Edit Data Masking 
page opens.
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2 If you need to apply a mask to a column, expand the table node that contains 
the column, for example, CUSTOMER. 

3 Select the table column, for example, CREDITCARD.

TIP You should not mask unique key columns.

4 Choose a value from Mask Type or, if you are using a mask you defined 
yourself, click Custom Masks. Refer to Pre-built masks (page 91) for more 
information.

Before you choose your data mask, consider all of the following:

• If you choose to mask a primary key, you need to ensure that the masked 
values are unique (a mapped mask). Otherwise, when you upload the 
table, it may no longer behave as expected

• You must ensure that the data mask you apply corresponds to the data 
type of the column. For example, if the column is a numeric value, you 
must apply a numeric mask to it or use a function to convert the data to a 
data type that is compatible with the mask. Otherwise, the mask will fail 
with a SQL error upon deployment.

Pre-built masks

Table 27 lists the string masks provided by HP Test Data Management.

WARNING! If your column contains any invalid data, such as invalid characters, 
the Social Security, credit card, and ABA/Routing string masks will not mask the 
value at all. For example, if you have a Social Security Number value that 
contains an invalid special character like #, none of that value will be masked in 
the extracted files. Hence, if invalid data is an issue in your columns, you may 
wish to create a custom mask that includes special logic for handling invalid data 
as you desire.

TIP The only reversible string mask is String map (Oracle only).

NOTE The pre-built data masking functions support generic data types, such as 
VARCHAR, CHAR, NUMBER, FLOAT, and so on. The pre-built masks will not 
work on columns that are database specific, such as unique identifier in SQL 
Server.
HP Test Data Management Developer’s guide 91



Table 27 Pre-built data masks—Strings

Mask Description

ABA/Routing number: 
random

Validates that the given ABA number adheres to 
a supported format and, if it does, returns a new 
valid random ABA number. Otherwise, it 

returns the same input number.a This mask 
supports a nine digit ABA number of the format 
XXXXXXXXX, where X is any digit [0-9]. The 
random number returned will always be the 
same for the number that is input. That is, for a 
given value x, the value y is always returned.

Credit card number: random Validates that the given credit card number 
adheres to a supported format and, if it does, 
returns a new, random credit card number of the 
same type. Otherwise, it returns the same input 

number.a This mask supports Visa, Master Card, 
American Express, and Discover card numbers. 
Refer to Credit card masks (page 98) for more 
information. The random number returned for 
the credit card number will always be the same 
for the number that is input. That is, for a given 
value x, the value y is always returned.

Credit card number: XXX mask Validates that the given credit card number 
adheres to a supported format and, if it does, 
returns the original number with all digits 
masked by X, except for the last four digits. 
Otherwise, the mask returns the same input 

number.a This mask supports Visa, Master Card, 
American Express, and Discover card numbers. 
Refer to Credit card masks (page 98) for more 
information.

Social Security Number: 
random

Validates the given US Social Security number 
adheres to a supported format and, if it does, 
returns a new, random Social Security Number 
starting with 897, which is not assigned to any 
individual and can be safely used. Otherwise, 

the mask returns the same input number.a The 
random social security number will always be 
the same for the number that is input. That is, 
for the value x, the value y is always returned.

This mask supports both formats, xxx-xx-xxxx 
and xxxxxxxxx. If the input contains dashes, 
this function returns a number with dashes 
inserted in the 4th and 7th place.
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Social Security Number: XXX 
mask

Validates that the given US Social Security 
number adheres to a supported format and, if it 
does, replaces all digits from the original 
number with letter X, except the last four digits. 
Otherwise, the mask returns the same input 

number.a

This mask supports both formats, xxx-xx-xxxx 
and xxxxxxxxx. If the input contains dashes, 
this function returns a number with dashes 
inserted in the 4th and 7th place.

String mask: random length Returns a string of random length, bounded by 
a user-specified maximum, using a 
user-specified character.

• Character (Data type Character) is the 
character to use in the string. You can 
specify any printable character.

• Length (Data type Integer) is the maximum 
allowable length of the string. The 
generated string will have a random length 
between 1 and the value of Length.

String mask: same length Returns a string of the same length using a 
user-specified character.

• Character (Data type Character) is the 
character to use in the string. You can 
specify any printable character.

Random string Returns a string of random length, bounded by a 
user-specified maximum, using the character X.

• Length (Data type Integer) is the maximum 
allowable length of the string. The generated 
string will have a length of the value of 
Length.

Random string: [a-z] Returns a string of random length, bounded by a 
user-specified maximum, using only the 
character I.

• Length (Data type Integer) is the maximum 
allowable length of the string. The generated 
string will have a length of the value of 
Length.

Table 27 Pre-built data masks—Strings

Mask Description
HP Test Data Management Developer’s guide 93



Random string: [A-Z] Returns a string of random length, bounded by a 
user-specified maximum, using only the 
character X.

• Length (Data type Integer) is the maximum 
allowable length of the string. The generated 
string will have a length of the value of 
Length.

Random string: [a-zA-Z] Returns a string of random length, bounded by a 
user-specified maximum, using only the 
character x.

Length (Data type Integer) is the maximum 
allowable length of the string. The generated 
string will have a length of the value of Length.

Table 27 Pre-built data masks—Strings

Mask Description
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Random string: [a-zA-Z0-9] Returns a string of random length, bounded by a 
user-specified maximum, using the character 0.

• Length (Data type Integer) is the maximum 
allowable length of the string. The generated 
string will have a length of the value of 
Length.

String map (Oracle only) Looks up a given string in a map and returns the 
value to which it is mapped. If a string is not 
mapped to any value, then a null string is 
returned.

This mask is reversible upon upload and thus 
the mapping must be complete (encompassing 
all values). If the mapping is not complete, an 
exception is thrown during extraction.

The mapping is stored in a lookup table, which 
you must create and populate prior to using this 
function. This mask supports VARCHAR 
columns up to 256 characters in length. It is best 
employed on short strings, such as zip code, 
driver’s license number, and telephone number.

The data type and lengths of the columns in the 
lookup table must match those of the columns in 
the managed tables. For example, if the column 
in the source table is VARCHAR(100), then the 
corresponding column in the lookup table must 
be VARCHAR(100) as well.

• Map table name (Data type VARCHAR) is 
the name of a lookup table. A lookup table 
has only two columns, both of type 
VARCHAR with a maximum size of 256 
characters:

— The column named orig holds the key.

— The column named masked holds the 
value.

The lookup table must be created and populated 
before using this mask. The lookup table must 
be created in the source database. 

Table 27 Pre-built data masks—Strings

Mask Description
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Table 28 lists the numeric masks provided by HP Test Data Management.

TIP The only reversible numeric masks are Skew number: add and Number map 
(Oracle only).

Fixed string Returns a constant, user-specified string.

• Value (Data type String) is the string with 
which to replace all values. This replacement 
string should be compatible with the 
column’s data type, for example, it should 
match the maximum length of the column.

a. Because returning the same number could be a security issue, you should con-
firm that the numbers are in valid format prior to running with this mask.

Table 27 Pre-built data masks—Strings

Mask Description

Table 28 Pre-built data masks—Numeric

Mask Description

Fixed number Returns a user-specified constant, numeric 
value.

• Value (Data type Numeric) is the constant 
with which to replace the column’s values. 
This number must be compatible with the 
column data type, for example, the precision 
and scale must match.

Random number Returns a random number within a 
user-specified range of values.

• Minimum (Data type Integer) is the lower 
bound of the range.

• Maximum (Data type Integer) is the upper 
bound of the range.

Skew number: add Returns a skewed value, the original value plus 
a user-specified number.

• Amount (Data type Integer) is the number 
by which to increment the original value. It 
must be a positive or negative whole 
number. 

This function is reversible.
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Table 29 lists the date masks provided by HP Test Data Management.

Skew number: multiply Returns a skewed value, the original number 
multiplied by a user-specified number.

• Amount (Data type Numeric) is the number 
by which to multiply the original value. 

For SQL Server, the result is rounded off to the 
nearest whole number.

Skew number: percent Returns a skewed value, the original number 
increased by a user-specified percentage. For 
example, to increment a number by 10%, enter 
10 for the Percent.

• Percent (Data type Numeric) is the 
percentage by which the original value will 
be increased. 

For SQL Server, the result is rounded off to the 
nearest whole number.

Number map (Oracle only) Looks up a given number in a map and returns 
the value to which it is mapped. 

This mask is reversible upon upload and thus 
the mapping must be complete (encompassing 
all values). If the mapping is not complete, an 
exception is thrown during extraction.

The mapping is stored in the lookup table, 
which you must populate prior to using this 
function.

• Map table name (Data type VARCHAR) is 
the name of a lookup table. A lookup table 
has only two columns, both of type 
VARCHAR:

— The column named orig holds the key.

— The column named masked holds the 
value.

The lookup table must be created and populated 
before using this mask. The lookup table must 
be created in the source database.

Table 28 Pre-built data masks—Numeric

Mask Description
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Credit card masks

Table 30 lists the credit card types and formats for which HP Test Data 
Management supports masking.

Table 29 Pre-built data masks—Date

Mask Description

Skew date Returns a skewed value, the original date plus a 
user-specified number of days.

• Days (Data type Integer) is the number of 
days by which to increment the original date.

This function is reversible.

Table 30 Supported credit card types and formats

Card type Prefix Length Format

American Express 34,36 15 123412345612345

17 1234-123456-12345

17 1234 123456 12345

Discover 6011 16 1234123412341234

19 1234-1234-1234-1234

19 1234 1234 1234 1234

Mastercard 51-55 16 1234123412341234

19 1234-1234-1234-1234

19 1234 1234 1234 1234

Visa 4 16 1234123412341234

19 1234-1234-1234-1234

19 1234 1234 1234 1234

13 1234123412345

Diners Card 
International

36 14 12341234561234

16 1234-123456-1234

16 1234 123456 1234

Diners Card Carte 
Blanche

300-305 14 123412345631234

16 1234-123456-1234 

16 1234 123456 1234 
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Custom masks

To create a custom mask:

1 You must write a masking function in PL/SQL or Transact-SQL for Oracle or 
SQL Server, respectively.

— Custom data masking takes only one parameter and it is the column to be 
masked. For example, if you are custom masking a column named 
DEPARTMENT, which is of data type A, then the signature of the custom 
data mask would be:

A MY_MASK(A in);

where MY_MASK is the name of the custom data masking function that 
are writing and A is the data type of the column being masked.

— For Oracle, the function name cannot contain the / character.

2 Ensure that the function compiles successfully.

3 Deploy the function on the source database.

4 In Designer, when you are ready to apply a custom data mask, type in the fully 
qualified name of your custom data mask function. For example, in Oracle, 
suppose you created a custom data masking function called MY_MASK in 
the package CUSTOM_MASKING and deployed it in a database named 
HRDB. The fully qualified name would be:

HRDB.CUSTOM_MASKING.MY_MASK.

5 In the environments in which you run the cartridge, ensure that the masking 
function is available in the source database and that the OBT_IF user has 
access permissions on it.When the business flow invoking the cartridge runs 
from the Web Console, HP Test Data Management runs the extraction process 
under the OBT_IF user. Hence, the masking function must be available and 
accessible by the OBT_IF user in the environment’s source database.

Deleting cartridges

1 Ensure that you have deleted calls to the cartridge from any business flows 
that reference it.

2 Select the cartridge you want to delete in the Project Navigator.

3 Right click and select Delete, or press the Delete key.
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7 Working with business flows 
A business flow is a set of activities including a cartridge and any other activities 
necessary to accomplish an extraction solution. 

This chapter includes: • About business flows (page 101)

• Creating a business flow (page 102)

• Adding a database to file cartridge (page 104)

• Adding schema-based cartridges (page 105)

• Splitting an activity (page 105)

• Adding or editing a script (page 106)

• Adding or editing a condition (page 108)

• Adding or editing an interrupt (page 108)

• Testing business flows (page 109)

• Deleting a business flow (page 110)

About business flows

Business flows consist of various activities that you want to perform in sequence. 
Some activities, such as extraction activities, can be split into steps and you can 
perform other activities in between those steps. For example, you might run a 
script that calculates the number of rows to be extracted in between the selection 
and copy steps of an extraction activity.

A business flow can include any of the following activities:

• Extraction activities that invoke an extract cartridge

• Conditions that enable you to branch your business flow

• Interrupts that stop your business flow

• Groovy scripts that perform some additional processing, including but not 
limited to any of the following:

— Executing operating system commands, such as copying a file, deleting a 
file, compressing a file, or transferring a file (ftp)

— Sending an email or other notification

— Database operations, such as dropping indexes, making a tablespace 
read-only, or analyzing statistics for a table
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You edit business flows in a graphical environment where you can easily see the 
relationships among activities.

Creating a business flow

1 Select the Business Flows node in the Project Navigator.

2 Right-click and select New Business Flow.

3 The New Business Flow window opens. 

4 Type a name for the business flow.

5 Click OK. The Business Flow Editor opens.

6 Click Properties to display and optionally change the business flow’s 
properties.

7 On the General tab, you can see the version of the business flow and order 
the parameters used by the business flow.
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8 Select the Installation tab. In the Code area, you can enter a Groovy script to 
be executed at deployment time. Templates provide Groovy script templates 
to help you get started.

9 Select the Custom Properties tab. The Custom Properties page opens and 
behaves similarly to the Custom Properties page for a database to file 
cartridge, Editing a database to file cartridge (page 80).
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10 Click OK.

11 You can now begin to add activities to your business flow. Refer to the 
following sections for more information:

— Adding a database to file cartridge (page 104)

— Splitting an activity (page 105)

— Adding or editing a script (page 106)

— Adding or editing a condition (page 108)

— Adding or editing an interrupt (page 108)

See also Generating and deploying (page 111) for more information on generating and 
deploying your business flow.

Adding a database to file cartridge

1 Expand the Business Flows node in the Project Navigator and double-click a 
business flow.

2 Click the Extract tool.

3 Click the location in the business flow where you want to add the cartridge. 
The dialog box displays.

4 Select a database to file cartridge from the list.

NOTE You must have already created the cartridge in your project for it to 
appear in this list. Refer to Creating a new cartridge (page 79) for more 
information about creating cartridges.
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5 For Selection, choose:

— Standard selection is a method of data selection that restricts itself to the 
rows identified by the model. It does not attempt to traverse related rows 
across multiple tables.

See also HP Test Data Management Concepts guide for more information about 
standard data selection methods.

6 Click OK. The activity is added to the business flow diagram. 

Adding schema-based cartridges

Adding a schema-based cartridge works the same way as Adding a database to file 
cartridge (page 104).

Splitting an activity

1 Expand the Business Flows node in the Project Navigator and double-click a 
business flow.

2 Right-click on an activity in the editor and select Split. The Split Activity 
window opens.

NOTE You cannot split an activity based on a schema-based cartridge.

3 Use the shuttle buttons to indicate where the job split should be located.

4 Click OK. The split activity is displayed.
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The bullets represent the steps of the job. Green bullets indicate that the 
activity contains the corresponding step. Empty bullets indicate that the 
activity does not contain the step. 

The step name is displayed when you move the mouse cursor over a bullet.

5 Repeat step 2 through step 4 until you have completed all the splits that you 
want in your business flow.

6 Delete an activity to reverse a split. The steps are merged into the remaining 
activity.

7 Save your work.

See also Generating and deploying (page 111) for more information on generating and 
deploying your business flow.

Adding or editing a script

Groovy scripts used in a business flow must be written in the Groovy language 
version 1.5. You should test your Groovy scripts in a standalone Groovy 
environment before including them in your business flow. 

NOTE HP Test Data Management does not validate your code. You must validate 
and ensure that your code performs as expected at runtime yourself.

Related information http://groovy.codehaus.org/

1 Expand the Business Flows node in the Project Navigator and double-click a 
business flow.

2 Click Groovy Script in the tool bar and drag it to the editor, or double-click an 
existing script activity. The Groovy Script dialog box opens. 

3 Type or edit the name for the script.

4 Type the Groovy code in the Code field.
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5 Optionally, click Parameters to add or edit a parameter. Refer to Creating or 
editing parameters using the Parameters button (page 65).

6 Click Template to choose a code template for your Groovy script.

a Select a template in one of the following categories:

– SQL against SOURCE database

– SQL against repository database

– Operating System

– Utilities

– Utilities - Install BF

b Click OK.

7 Edit the code as necessary.

The code you type is analyzed. If there are any errors, the error message is 
displayed at the bottom of the window.

Click the error message to move the caret to the error position.

8 Click OK.

9 Save your work.

See also Generating and deploying (page 111) for information on generating and deploying 
your Business Flow.
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Adding or editing a condition

In some cases, you may want to check some condition before proceeding with an 
activity in your business flow. If the condition is met, then you will proceed with 
the activity. If not, you skip the activity and go to the next activity, if there is one, 
or end the business flow.

1 Expand the Business Flows node in the Project Navigator and double-click a 
business flow.

2 Click Condition in the tool bar and drag it to the editor, or double-click an 
existing condition. The dialog box opens. 

3 Type or edit the name for the script.

4 Type or edit the Groovy code in the Code field for your condition. The code 
must return a Boolean value to indicate whether the condition was met. For 
example, you might enter something like:

import java.io.*
new File("c:/temp/x.txt").exists()

5 Click OK. Your condition is created or modified. Notice the bounding box 
around the condition.

6 To place an activity within the condition, click a tool in the tool bar (Extract, 
Groovy Script, Condition, Interrupt). 

7 Click inside the bounding box of the condition and complete the resulting 
dialog as necessary. The activity will be governed by the condition. If the 
condition returns true, the activities inside of its bounding box are executed. If 
the condition returns false, the activities inside of the bounding box are 
skipped.

NOTE You cannot split a copy activity and place some of its pre- or 
post-activities inside of the condition and some outside the condition. All of 
pre- and post-activities for the copy must be contained either inside or outside 
of the condition. To stop execution between pre- and post-activities of a copy 
activity, you can use an interrupt. Refer to Adding or editing an interrupt 
(page 108)

8 Repeat step 6 and step 7 for any additional activities you want to be under the 
control of the condition.

Adding or editing an interrupt

In some cases, you may wish to stop or pause your business flow, typically after 
checking some condition. To stop or pause a business flow at any point, you can 
introduce an interrupt into the business flow.

1 Expand the Business Flows node in the Project Navigator and double-click a 
business flow.
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2 Click Interrupt in the tool bar and drag it to the editor, or double-click an 
existing interrupt activity. The Interrupt Flow Activity dialog box opens. 

3 Choose the Type of interrupt you want to create.

— Error means that the business flow stops with an error condition, 
meaning that it cannot continue.

— Pause means that the business flow execution is temporarily suspended 
and can be continued later.

— Exit Successfully means that the business flow completed its activities 
successfully.

— Exit with Warning means that the business flow completed, but some 
activities caused warnings to be issued.

4 Type or edit the Message to display when the interrupt is executed.

5 In Condition, type the Groovy code for your condition. The code must return 
a Boolean value to indicate whether the condition was met. For example, you 
might enter something like:

import java.io.*
new File("c:/temp/x.txt").exists()

TIP A condition is required if your interrupt type is Error. For the other types 
of interrupt, a condition is optional.

6 Click OK. Your interrupt is created. 

Testing business flows

With any business flow, you should carefully test it before running it in your 
production environment. As best practice, you should: 

• Thoroughly test and debug your Groovy scripts in a Groovy IDE.
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• For interrupts and conditions, ensure that you have test cases that meet and do 
not meet the condition. Otherwise, you cannot exercise all branches.

• Preview any models referenced by cartridges in your business flow. Ensure 
that you vary parameter values within reasonable ranges.

• Preview any extraction cartridges used in your business flow.

• Deploy and run the business flow in a development environment. Carefully 
check all logs and confirm all results before trying the business flow in 
production.

See also HP Test Data Management Troubleshooting guide

Deleting a business flow

1 In the Project Navigator, select the business flow you want to delete.

2 Right click the business flow and choose Delete, or simply press the Delete 
key.
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8 Generating and deploying
After your cartridge or business flow is complete and tested, you are ready to try 
running it on the actual active database, outside of Designer. In order to run 
against your active database, you must first deploy the business flow or cartridge 
to your deployment environment. The deployment environment is where HP Test 
Data Management actually perform operations on your specified source (active) 
database. Until your cartridge or business flow is deployed to the environment, 
you cannot execute it.

This chapter includes: • Deploying locally (page 111)

• Deploying remotely (page 114)

• Generating deployment files (page 116)

Deploying locally

Local deployment allows you to deploy a cartridge or business flow to the same 
system for which Designer is configured. Deployment Assistant displays different 
pages depending on the type of cartridge you are deploying.

NOTE When you deploy a cartridge by itself, HP Test Data Management wraps it 
in a business flow for deployment purposes.

This section includes: • Deploying a schema-based database to file cartridge (page 111)

• Deploying a business flow (page 114)

Deploying a schema-based database to file cartridge

1 In Designer, expand Cartridges in the Project Navigator. 

2 Right click the database to file or schema-based database to file cartridge you 
want to deploy and select Deploy. The Deployment Assistant opens. 

3 Select the Deploy Locally radio button.
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4 Optionally, check Include Documentation.

See also Annotating projects (page 21)

5 Click Next.

See also 6 Choose:

— Standard. Standard is a method of data selection that restricts itself to the 
rows identified by the model. It does not attempt to traverse related rows 
across multiple tables.

7 Click Next.

8 Type the encryption key value, which was defined during the repository 
installation. For example, EKEY. The encryption key is case sensitive. The 
encryption key is remembered for the rest of the session.
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9 Click Next.

10 Choose an environment, then click Next.

11 Enter the login information for your active database, then click Next.

12 On the Summary page, click Finish. Your cartridge may take a few moments 
to deploy.
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Deploying a business flow

1 In Designer, expand Business Flows in the Project Navigator. 

2 Right click on the business flow you want to deploy and select Deploy. The 
Deployment Assistant opens. 

3 Select the Deploy Locally radio button.

4 Optionally, check Include Documentation. 

See also Annotating projects (page 21)

5 Click Next.

6 Type the encryption key value. For example, EKEY. The encryption key is 
case sensitive. The encryption key is remembered for the rest of the session.

7 Enter the login information for your active database as described in step 11 
(page 113) through step 12 (page 113).

Deploying remotely

Remote deployment allows you to deploy from Designer to a system that is 
remote from the database for which Designer is installed and configured.
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NOTE The Web Console must have already been started on the remote machine 
for this procedure.

1 In Designer, expand Cartridges or Business Flows in the Project Navigator. 

2 Right click on the cartridge or business flow you want to deploy and select 
Deploy. The Deployment Assistant opens. 

3 Select the Deploy Remotely radio button.

4 For Web Console URL, enter the URL for the Web Console associated with 
the remote repository database to which you want to deploy. 

5 Enter the Web Console user name under which you plan to deploy, for 
example, admin.

6 Enter the password for the Web Console user you specified in the previous 
step.

7 Optionally, check Include Documentation.

See also Annotating projects (page 21)

8 Click Next.

9 From this point forward, the Deployment Assistant behaves in much the same 
manner it would for a local deployment:

See: — Deploying a schema-based database to file cartridge (page 111)

— Deploying a business flow (page 114)
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Generating deployment files

In some cases, you may not have direct access to the production system where the 
business flow or cartridge is to be deployed. For example, you might be providing 
cartridges or business flows to another organization with systems separate from 
your own. In such situations, you can generate the deployment files for your 
cartridges and business flows, and then move those files to the other system for 
subsequent deployment. You can generate and deploy as follows:

1 Generate a deployment file from the Deployment Assistant configured with 
your development instance (that is, the database for which Designer is 
installed and configured). 

— Generating a cartridge or business flow (page 116)

2 Move the deployment file to the remote system and invoke the Web Console 
associated with the remote system to deploy that file. 

— Deploying generated files (page 117)

Generating a cartridge or business flow

1 In Designer, expand Cartridges or Business Flows in the Project Navigator. 

2 Right click on the cartridge or business flow you want to deploy and select 
Deploy. The Deployment Assistant opens. 

3 Select the Generate radio button.

4 Optionally, check Include Documentation.

See also Annotating projects (page 21)
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5 Click Next.

6 If you are deploying a cartridge, you are prompted to choose the data selection 
and movement methods. If you are deploying a business flow, you will 
proceed directly to step 8 (page 117).

7 Choose the selection and data movement methods from the lists of values and 
click Next.

8 Type or browse to the location where you want to store the deployment file. 
For the sake of convenience, you may wish to choose a path (a network or 
shared drive) that is accessible from the remote system on which you plan to 
deploy the cartridge or business flow. Otherwise, you will need to move the 
deployment files to such a location after you generate them.

9 Click Finish. The deployment file is generated in the path that you chose in 
the Deployment Assistant. In that path, you should find a .busflow file with 
the same name as your business flow or cartridge. If you chose to include 
documentation, you should also find a PDF file in the same path.

10 Perform the steps in Deploying generated files (page 117) on the remote 
system where you want to deploy and run the business flow or cartridge.

Deploying generated files

Before performing the steps in this section, you must have performed the steps in 
Generating a cartridge or business flow (page 116) and have a login with 
deployment privileges to the Web Console for the system where you plan to 
deploy.
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NOTE The Web Console must have already been started on the remote machine 
for this procedure.

1 In a browser, invoke the Web Console URL for the system where you want to 
deploy and run the business flow or cartridge (http://<hostname>:8080/
WebConsole).

2 Login as a user with privileges to deploy business flows, for example, admin. 
Ensure that the currently active environment is the one in which you want to 
deploy the business flow.

3 From the menu at the top of the page, choose Business Flow Deployment. If 
you stored the generated files in <install_dir>\obt\businessflow, then 
they will appear in the list of business flows available for deployment. If you 
do not see the business flows you want to choose in the list, do the following:

a Click Import in the left navigation pane.

b Import the business flows in one of two ways:

– Choose the Path to the Server directory radio button, enter a valid 
path on the server where the deployment files (*.busflow) are stored, 
and click Copy.

– Choose the Business flow file to upload radio button and click 
Browse to select the deployment files (*.busflow).

The business flows are uploaded from the client to the server.

c From the menu at the top of the page, choose Business Flow 
Deployment. The business flow(s) that you just imported should now 
appear in the list.

4 Check the business flow(s) in the list that you wish to deploy.

5 Click Next.

6 Depending upon the type of cartridge(s) contained in the business flow(s), 
pages will appear where you can provide the necessary information for 
deployment. For more information on deployment through the Web Console, 
refer to HP Test Data Management Runtime guide.

7 When you reach the summary page, click Finish to deploy your business flow.
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9 Customizing extraction projects
Using Designer, you can safely customize a project you receive from a third party. 
When the third party releases revisions to the project, you can merge your 
customizations into the revised project from the third party. Thus, you need not 
constantly repeat your changes each time you receive a revision from the vendor.

This chapter explains, for consumers, how to customize a project you receive and 
merge new versions with your customizations. 

NOTE If you are a third part vendor developing projects for consumption, you 
should contact HP about becoming a partner and learning more about developing 
customizable projects.

This chapter includes: • About customization (page 119)

• Guidelines for customizations (page 120)

• Customizing a project (page 121)

• Merging customizations into a new project revision (page 122)

About customization

When you receive a project that was pre-built, you typically need to modify the 
project for your environment. For example, you might need to add to the model 
some tables that are required by your environment but that are not part of a default 
implementation of the packaged application. 

As a consumer of a customizable extraction project, you must be aware of several 
considerations and tasks:

• When you receive a project, it should be locked. When a project is locked by a 
vendor, it means that the various files that comprise the project are all locked. 
For example, each model in a project has a file associated with it. When the 
vendor locks the project, the existing model files are all locked. 

TIP Note that if you take an action, such as adding a new model to the project, 
that results in the creation of a new file, then the new file would not be locked.

• Even though the project is locked, you can perform most modifications that 
you like on it. You should be aware, though, that some modifications may 
cause the modified model, cartridge, business flow, or parameter to be 
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unsupported when upgraded to a newer revision of the project. To ensure that 
your modifications are completely supported, you should modify the project 
according to the guidelines in Guidelines for customizations (page 120).

• Generate a list of unique identifiers (UIDs) to use in validating your 
customizations.

• When the vendor releases new versions of the project, merge your 
customizations into the new version.

Guidelines for customizations

As you customize a project, you must take the following into account:

• By default, locked projects open in what is known as Customization view. In 
this mode, Designer gives you various visual cues in the form of icons in the 
model editor, to call out customizations. You can toggle Customization view 
on and off from the toolbar using the Custom View tool.

• Ensure that the project files are locked before you begin making 
modifications. If the Custom View tool in the model editor is disabled, it 
means that the files are not locked. If the files are not locked, you should lock 
them before you begin by selecting Customization > Lock Project.

• You can make modifications to the model and cartridges in a locked project. 
As long as you adhere to the guidelines in this section, those customizations 
are supported, which means you can merge them into a new version of the 
project when you receive it.

• When you make certain changes to the model or cartridge in a locked project, 
you receive confirmation dialogs with warning messages to ensure that you 
really want to make the change.

If you click OK, the operation is carried out and, in the model editor, the 
object is marked in some fashion to indicate the customization.

• You can add new models, cartridges, business flows, and parameters to the 
project, but note that they are not locked because they create new unlocked 
files within the project.
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• In a locked project, if you delete an original table use or a mandatory rule, it is 
marked as deleted rather than actually deleted. If you unlock the project, 
objects marked as deleted are actually removed. Similarly, if you add new 
tables or rules to a locked project, these are not added to the base project. If 
you unlock the project, then the new objects are added to the base project.

• Because original tables are not actually removed from a locked project, you 
need to take special care when removing a table. If you later recreate that table 
in the model, you could end up with the same table in the model twice, which 
could cause problems for you at some point.

• Each rule in the project is categorized according to its Customization property 
as follows:

— Optional rules can be changed or deleted without triggering warnings or 
changing the UID.

— Recommended rules can also be changed or deleted but only with great 
caution. Changing a recommended rule will trigger a warning, but the 
UID is not changed.

— Mandatory rules cannot be changed or deleted. Such changes trigger a 
warning and cause the UID to change. If you choose to make the change 
anyway, the original rule is marked as deleted and a new rule is created to 
replace it.

• Business flow changes are not merged. If you make changes to a business 
flow, you cannot merge those customizations into a new version of the 
original project.

Customizing a project

When you receive a new project to customize, you first import it into Designer for 
customization. Once you have the project in Designer, you can modify it and 
generate its UIDs for future reference when you merge a new version from the 
vendor with your modifications.

1 In Designer, choose File > New Project. The New Project dialog box 
displays.

2 Enter a name for the project and select Customize an Existing Project.

3 Click OK. The Import Project dialog, from which you can select a .hdp file, 
displays.

4 Browse to and select the .hdp that you received from your vendor.

5 Click Open. The selected project is imported into Designer under the 
specified project name.

6 When you receive a new project, ensure that the project is locked. Open a 
model in the project for editing and, if the Custom View tool in the toolbar is 
disabled, it means that the project is not locked. If the project is not locked, 
you should lock it before you begin by selecting Customization > Lock 
Project.
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7 Modify the project as desired but within the guidelines described in 
Guidelines for customizations (page 120).

8 Save the project.

9 Choose Customization > Generate UIDs.

10 Click Copy to Clipboard.

11 Paste the UIDs into a document and save it for future reference.

12 Click OK in the Unique IDs dialog box.

Merging customizations into a new project revision

TIP Before merging customizations, you should backup your project files.

1 Open your customized version of the project.

2 Review the guidelines in Guidelines for customizations (page 120) to ensure 
that you understand which of your modifications will be merged and 
supported.

3 Choose Customization > Merge Project.

4 In the Merge Project dialog box, browse for the new project file from your 
vendor, which has the .hdp extension.

TIP .hdp is an exchange format for HP Test Data Management projects and 
contains all of the files associated with the project. You create .hdp files by 
exporting a project from Designer, File > Export Project.

5 Click OK.

6 Optionally, if you find that some of your customizations were not merged, 
compare the UIDs from your customized project to those of the developer’s 
original project. Wherever the UIDs do not match, it indicates that you have 
an unsupported change.

TIP If you want to create a new project based on a project from a vendor, you can 
do so by choosing File > New Project and checking Customize an Existing 
Project. Refer to Creating a new project (page 18) for more details.
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Glossary
active database The database from which you plan to extract data. Typically, this database is your 
online transaction processing (OLTP) or production database. In a two-tiered 
configuration, the active database resides on tier one and is the source for data 
movement operations.

active environment The Web Console views and acts upon only one environment at a time, the active 
environment. To switch the active environment, you use the Change Active option 
in the Web Console.

activity In Designer, a component of a business flow, which is added by using the toolbar. 
Note, activities in a business flow are different from what you see at runtime and 
therefore do not necessarily map directly to what you see in Console. 

advanced selection A method of data selection that discovers all of the interrelated rows from 
multiple tables and conceptually places them in the same application partition for 
extraction.

annotation In Designer, a comment associated with the project, or one of its objects or 
components. These comments are collected and published in a PDF file when you 
right click a project or business flow and select Generate Documentation. 

application partitioning The concept of partitioning related rows together during data selection, regardless 
of whether they are in one or more tables. Application partitioning is unique to HP 
Test Data Management and contrasts with the more common table partitioning 
offered by the database management software, which only groups related rows 
from one table.

business flow A series of activities, such as extraction operations and scripts, that run in 
sequence. You build business flows in Designer.

business flow status The Web Console shows the last run of each business flow. The states are 
Complete/Error/Running.

cartridge An instance of model- or schema-based eligibility criteria used to copy data from 
one location to another. Cartridges capture the application and business rules to 
ensure referential integrity of the data. For any one model in your project, you 
may have many cartridges that use it.

chaining table The lower level table in a many-to-one or a many-to-many relationship between 
higher level and lower level tables in the model hierarchy. 

collection The configuration of a directory location and file pattern to match a set of 
extracted XML files, thus allowing SQL access to the extracted data.
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comma separated values 
(CSV)

A database to file output format that stores the data as values separated by 
commas and a metadata file. Each line in the CSV file corresponds to a row in a 
table. Within a line, fields are separated by commas, each field belonging to one 
table column. CSV files provide a simple format that many applications can 
import.

command Command files or JavaScript files launched by the Web Console on your behalf 
with status displays.

condition In Designer, the way you branch your business flow to run or skip an activity 
based on some criteria.

configuration parameter A type of parameter that has its values set by an administrator (someone who has 
repository privileges from Console) through the administrator interface. Typically, 
this type of parameter represents values that should be changed very infrequently, 
perhaps only at deployment time.

console user The Web Console identifies individual users, who are distinct from database 
users. The properties for a Console user are User Name, Full Name, Password, 
Enabled, Description, Email, Phone, and Privileges.

console user name The login name associated with a Console user.

constraint A column or a list of columns that enables you to identify rows in the database and 
relate them to one another.

customization A change that an administrator or DBA makes to a project provided by a third 
party, typically for a packaged application like Oracle PeopleSoft or Oracle 
E-Business Suite. As long as the customization is allowable by the project, the 
user can merge the customization into newer revisions of the third party project. 

customization mode A Designer mode that provides visual cues to indicate customizations in the 
model. In a project with locked files, customization mode is on by default, but you 
can toggle it on and off from the toolbar in the model editor.

data masking The process of replacing private or confidential data during movement with a 
specified mask. You can choose from pre-defined masks that are part of HP Test 
Data Management or create your own mask.

data movement The method used by HP Test Data Management to actually copy data.

database constraint A constraint that exists in the database and can be discovered and referenced from 
Designer.

database to file A movement in which data goes from an active database to a file (XML or CSV 
format).

Deployment Assistant The user interface component used to deploy or generate business flows. You 
invoke Deployment Assistant from within Designer. 
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description A technical description created by the developer for her own reference. These 
descriptions do not appear in the generated PDF file for the cartridge or business 
flow.

Designer The user interface component used to develop, test, and deploy your extraction 
solution. Designer is a powerful graphical development environment for 
extraction solutions.

driving table A driving object is a root of a model hierarchy. Its relationship to the child tables 
drives the selection of transactions.

dynamic list of values A list of values for a parameter that obtains its members from a SELECT 
statement that returns identifiers and labels.

dynamic parameter A type of parameter that has its value set by a Groovy script that runs at 
deployment time to obtain a value. For example, this type of parameter can supply 
the type or version of a database or application, which can be obtained 
programmatically at deployment time. 

embedded repository A Java database, installed with HP Test Data Management, that can act as your 
repository database, where you store your HP Test Data Management metadata. 
Alternatively, your source database or another database can act as the repository 
database.

environment The source and (optional) target credentials against which you plan to run 
commands. You can define multiple environments within your installation to 
identify various source databases. 

error One of the ways in which you can interrupt a business flow. Error indicates that 
the business flow failed for some reason.

exclusive rules One of the ways in which HP Test Data Management determines whether to 
include or exclude rows from the extract operation. Exclusive rules require all 
rows in the constraint table to match for inclusion. Exclusive rules exclude the 
instance if the condition on any child is false, like STATUS=’CLOSED’.

exit One of the ways in which you can interrupt a business flow. You can exit 
successfully or with a warning.

export The way that you save an HP Test Data Management project to an exchange 
format (.hdp) from the File menu. See also import.

export data The way that a user can send data to CSV format from Preview using the toolbar 
item.

extract data store The location where the data is to be copied. Can be an XML or CVS file.

generate documentation The process of collecting and grouping all annotations into a PDF file that also 
describes the business flow or cartridge structure.
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import The way that you transfer projects from exchange format (.hdp) into the Project 
Navigator. 

inclusive rules One of the ways in which HP Test Data Management determines whether to 
include or exclude rows from the extract operation. Inclusive rules require only 
one row in the constraint table to match the rule and be included. Inclusive rules 
include the instance if the condition on any child is true, like 
PRODUCT_RECALLED=’Y’. 

interrupt The way to stop or pause a business flow (pause, error, exit with warning, exit 
successfully). 

local cache A capture of the metadata for your databases, schemas, and tables used when 
working offline in Designer.

local deployment The generation and deployment of your cartridge or business flow to an 
environment on your local, Designer client. Deployment files are generated 
locally and then deployed to the designated, local environment. 

lookup table A table that contains helpful non-transactional information. For example, 
non-transactional information could be status definitions, or the name of the sales 
representative.

model A model identifies the tables and table relationships representing a business entity 
or related business entities. A project can have multiple models. Each model 
contains a driving table and all of its child and descendent tables.

model compatibility Each model in your project can have one or more dynamic parameters associated 
with it to verify the compatibility with the target environment. If the compatibility 
parameter returns false, then the cartridge referencing the model will not deploy 
or run and throw an error. For example, the script could return false for Oracle 
10.2 and true for Oracle 11.1 to indicate that a cartridge referencing the model can 
only deploy and run against Oracle 11.1. 

model-based cartridge A cartridge that moves data based upon a defined data model with relationships. 
This type of cartridge is typically used for ongoing extract operations. 

OLTP database The online transaction processing database that typically is your active or source 
database.

pause One of the ways in which you can interrupt a business flow. Pausing suspends the 
business flow while awaiting operator intervention.

query server The component that provides SQL access to XML or CSVfiles.

remote deployment The generation and deployment of your cartridge or business flow to an 
environment on a system that is remote from your Designer client. Deployment 
files are generated locally and then deployed to the designated, remote 
environment.
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repository The location that holds business flow metadata, product configuration data, and 
data collected during runtime. The repository can be located on your active 
database, another logical database, or can be embedded database. 

rule Qualifications added to the model in order to include or exclude data based on 
certain criteria. For example, you might add a rule to exclude from extracting any 
orders that are not yet closed.

runtime parameter A type of parameter that has its values set by the operator executing the job in 
Console or on the command line. Typically, this type of parameter represents 
operational values that tend to change frequently and therefore need to be set each 
time the job is run. 

schema-based cartridge A cartridge that moves data based upon the database schema rather than a defined 
data model with relationships. This type of cartridge is typically used for database 
retirement or the cleanup of orphan tables.

selection The form of data selection to use (standard or advanced) for choosing data. When 
creating a cartridge or adding it to a business flow, you must specify the selection 
method.

source The location (database) from which you are copying or moving data.

standard selection A method of data selection that restricts itself to the rows identified by the model. 
Unlike advanced selection, it does not attempt to traverse related rows across 
multiple tables.

table use A database table, view, or synonym that is referenced in Designer, for example, in 
the model. The same table can be used multiple times in a model. For example, a 
table could be appear as a transactional table and a lookup table in the same 
model.

target The location (XML) to which you are copying data.

transactional data 
movement

Transactional movement uses set-based data movement and is the default method 
of movement.

transactional table A table that contains information about the business transaction. For example, a 
transactional table might contain detailed tax or payment information related to 
each business transaction.

unique identifiers (UIDs) A 16 hexadecimal identifier calculated based on the content of a Designer file. 
This value is used to determine if the user has customized key pieces of a project.

virtual constraint A constraint that you define in Designer that only exists within HP Test Data 
Management as opposed to a database constraint, which exists within the 
database.

Web Console A browser-based interface where you can create and manage your deployment 
environments, and deploy, run, administer, and monitor your business flows.
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